Rozdziat 10 Dodatkowe wyjasnienia 617

Szczegoty obstugi programow
Zawartosc tej czesci bardzo przypomina zawartos¢ plikbw podpowiedzi do trzech programoéw: GIMP, Inkscape i

Belndera. Sg tu zestawione opisy tych polecen, ktére zostalty wykorzystane w poprzednich czesciach ksigzki.

Gdybys chciat wydrukowac¢ te ksigzke na wkasne potrzeby, rozwaz, czy przynajmniej tej czesci nie pozostawi¢ w
postaci elektronicznej. W przegladarce PDF szybciej znajdziesz podang w tekscie strone, niz kartkujac gruby
wydruk. (No i zuzyjesz mniej drzew z laséw...).
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618 SzczegOly obstugi programow

Rozdziat 11. GIMP — szczeg0ty obstugi

Nazwa GIMP pochodzi, jak sadze, od pierwszych liter angielskiego Graphic Image Processor. Jest to jeden z
pierwszych, duzych i ukohczonych projektéw Open Source.
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Rozdziat 11 GIMP — szczegOty obstugi 619

11.1  Instalacja

Po uruchomieniu programu instalacyjnego pojawia sie ekran "powitalny", a nastepnie ekran z umowa licencyjng
(Rysunek 11.1.1):

12 Setup - GIMP =3 12 Setup - GIMP

License Agreement
§ Welcome to the GIMP Setup Please read the following important information before continuing «
‘ Wizard 4

This will install GIMP 2.4 4 on your computer. When you are ready to cortinue with Setup, click Next.

It is recommended that you close all other applications before

continuing IGNU General Public License

Click Next to continue, or Cancel to exit Setup. Version 2, June 1991

copyright (c) 1989, 1991 Free Softuare Foundation

ST emele Fiace - butte 130, Besten, WA CRLL-A307 U3

Eyeryone fs permitted to copy and distribute verbatin copies
this Vicense document, but changing it is not a1

Preamble

The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
license is intended tn nnarantee wvaur freedom tn share and channe &

<Back | Net> | [ Cancel

Rysunek 11.1.1 Instalacja GIMP — pierwsze dwa ekran y

Po naci$nieciu przycisku | Agree na ekranie License Agreement, przejdziemy do ekranu Ready to Install
(Rysunek 11.1.2). Mozna tu wybra¢ normalng, "szybkg" instalacje (Install Now ) lub nietypowa (Customize ):

1! Setup - GIMP

Ready to Install
Setup is now ready to begin installing GIMP on your computer,
u

The GIMP is now ready to be installed

Install now

Cooa ] e | (o]

Rysunek 11.1.2 Wybér drogi instalacji

Jezeli nacisniesz przycisk Install Now, zainstalujesz program z domysinymi ustawieniami. W takim przypadku
po tym ekranie zobaczysz od razu ekran postepu i finalny (Rysunek 11.1.7).
Jezeli jednak nacisniesz przycisk Customize, pojawig sie kolejne ekrany.

Pierwsze z nich pozwalajg Ci okresli¢ folder programu i skfadniki, jakie majg by¢ wgrane na Twoj komputer
(Rysunek 11.1.3):

18! Setup - GIMP 18 Setup - GIMP

Select Destination Location Select Components
Where should GIMP be installed? Which components should be installed?
u

Select th et it to install; clear th rits you do not wart f
(] Setup willnstall GIMP intothe folowing folder LR N i ris e
To continue, click Next. if you would like to select a different folder, click Browse ! Fullinstallation 5 |
; Descrption
[c\Program Fies\GIMP | [ Browse 3 5

MS-Windows engine for GTK+ 0,1 MB

Translations 208 MB

At least 40,2 MB of free disk space s required Current selection reqires at lsast 80,3 ME of disk space
[ <Back J[_Net> ] [ Cancel ] <Back | Nex> ] [ Cancel

Rysunek 11.1.3 GIMP — wybor folderu i sktadnikéw pr  ogramu
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620 SzczegOly obstugi programow

Nastepny (Select file associations ) pozwala wybra¢ formaty obrazéw, dla ktérych GIMP ma by¢ domysinym
programem do wyswietlania/ edycji. Zaznacz tu m.in. formaty: GIF, PCX ():

15 Setup - GIMP

18 Setup - GIMP

Select file associations Select file associations

Select file associations Select file associations
Select the file types you wish to associate with GIMP Select the file types you wish to associate with GIMP
This will make selected files open in the GIMP when you double-click them in Explorer.

This wil make selected files open in the GIMP when you double-cick them in Explorer
GIMP imags - [ Tagged Image Fie

[ Adobe Photoshopfm)image 3 TrueVision Targa

[] AlissMiavefront PowerAnimitor [ Windows ang/(9572 Btmaps
W Compuserve GIF [ Windows Ipn
[Wgital Imaging and Communications in Medicine

-~
Zaznacz format PCX |
(na koncu listy)

[[] FlexibleMage Transport Systey

[1 X Ppmap
GIMF brushyipe IZaznacz format GIF | Fl
GIMP brush 13
GIMP pattem i i
Extensions: gif Select Unused Select All Extensions: pox Select Unused Select All

[ <Back J[_Net> ] [ Cancel ]

[ <Back J[_Net> ] [ Cancel ]

Rysunek 11.1.4 Ustalanie domy $lInie obstugiwanych formatéw plikow

Wreszcie ustalane sg szczegoly reprezentacji w menu i na pulpicie (Rysunek 11.1.5):

1B Setup - GIMP

1B Setup - GIMP

Select Start Menu Folder Select Additional Tasks
‘Where should Setup place the program’s shortcuts?

‘Which additional tasks should be performed?

= Select the additional task: ld like Setup to perf; hile installing GIMP, th
Setup will create the program’s shortcuts in the following Start Menu folder. d‘eck N;.a e ="
To continue, click Next. If you would like to select a dfferert folder, click Browss

Addtional icons:

Create a deskiop icon
| [ Erowse..
[] Greste a Guick Launchicon

[[] Dont create & Start Menu folder

l < Back “ Next > 1[ Cancel ]

< Back “ Next > 1[ Cancel

Rysunek 11.1.5 Instalacja GIMP — szczegéty reprezen  tacji

Na zakonczenie program wy$wietla podsumowanie wybranych opcji (Rysunek 11.1.6):

1! Setup - GIMP

Ready to Install
Setup is now ready to begin installing GIMP on your computer,

Click Install to continue with the installation, or click Back i you want to review or
change any settings.

Destination location: ~
F:\Program Files\GIMP

Setup type:

Fullinstallation

'selected components:

The GIMP

GTK+ Run-time Environment 2.12.5

MS-Windows engine for GTK+
Translations

File types to associate with the GIMP:
xcf, gih, gbr, gpb, pat, tga, wmf, pcx
iStart Menu folder:

£

[ < Back ” Install I[ Cancel

Rysunek 11.1.6 Instalacja GIMP — wyliczenie wybrany  ch opciji
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Rozdziat 11 GIMP — szczegOty obstugi 621

Po nacisnieciu przycisku Install rozpoczyna sie instalacja (Rysunek 11.1.7):

18 Setup - GIMP =

15 Setup - GIMP

Installing
Please wait while Setup installs GIMP on your computer.

| Completing the GIMP Setup

t . Wizard

Setup has finished instaling GIMP on your compiter. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup

Launch The GIMP

Edracting files...

F:\Program Files\GIMP-2.0'bin‘iconv.dil

Rysunek 11.1.7 Instalacja GIMP - ekrany: post epu i finalny

Po zainstalowaniu GIMP, mozesz takze zainstalowa¢ rozbudowany system podpowiedzi (Help) (Rysunek
11.1.8). Program instalacyjny moze by¢ pobrany z Internetu, (z tej samej witryny, co GIMP):

1B Setup - The GIMP

1B Setup - The GIMP

Ready to Install
W_elcome to the GIMP HC||3 Setup Setup is now ready to begin instaling The GIMP on your computer.
Wizard
This will install GIMP Help 2-2.4.0 on your computer. Click Install to continue with the installation, or click Back i you want to review or
change any settings.
It is recommended that you close all other applications befors
continuing. Gimp 2 was found in:
[ErPr F:\Program Files\GIMP-2.0
- Click Next to continue, or Cancel to exit Setup
o) ‘J
p
< Back “ Install 1 l Cancel

Rysunek 11.1.8 Pierwsze dwa ekrany instalacji podpo  wiedzi

Po nacisnieciu na ekranie Ready to Install przycisku Install, rozpoczyna sie kopiowanie plikow (Rysunek 11.1.9):

1B Setup - The GIMP 1B Setup - The GIMP

Installing -
Please wait while Setup installs The GIMP on your computer. Co_mphft'“g the The GIMP Setup
Wizard
Edracting files Setup has finished installing The GIMP on your computer.

Click Finish to exit Setup.

f
L [e—

Rysunek 11.1.9 Instalacja GIMP — ekrany post epu i finalny

Instalacja systemu podpowiedzi konczy sie ekranem finalnym (Rysunek 11.1.9).
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622 SzczegOly obstugi programow

Opcjonalnie, mozesz jeszcze doda¢ do Gimpa wtyczke, ktéra stuzy to generowania tzw. map normalnych (be-
dziemy ich uzywac¢ do odwzorowania drobnych nieréwnosci na naszym modelu — por. str. 410, 675). Po rozpa-
kowaniu towarzyszacego tej ksigzce pliku source.zip, znajdziesz w folderze source\gimp\ plik o nazwie gimp-
normalmap-win32-1.2.2.zip. To spakowane pliki wtyczki, w wersji dla Windows (32 bit). Zgodnie z zatagczong do
niej instrukcja, nalezy:
1. rozpakowaé plik normalmap.exe do folderu wtyczek GIMP (zazwyczaj to C:\Program Files\GIMP-
2.0\lib\gimp\2.0\plug-ins\ );
2. rozpakowac znajdujace sie w pakiecie 3 pliki *.dll do folderu, gdzie sie znajdujg pliki wykonywalne GIMP
(zazwyczaj to C:\Program Files\GIMP-2.0\bin\);

Przy najblizszym uruchomieniu GIMP odnajdzie te wtyczke i umiesci jej wywotanie w menu Filters 2Map jako
polecenie Normalmap...
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11.2

Wprowadzenie (GIMP 2.4)

tadowanie wszystkich komponentéw zajmuje Gimpowi pare sekund podczas uruchamiania. W tym czasie po-
kazywane jest "okno startowe" (Rysunek 11.2.1):

Looking for data files |
Modues ql

Rysunek 11.2.1 Okno startowe GIMP — pokazuje post

ep tadowania komponentéw

Po zakonczeniu tadowania, ujrzysz gtéwne okno programu. Pelni ono jednoczes$nie role przybornika narzedzi
(Rysunek 11.2.2). (Uwaga: GIMP 2.6 wyglgda nieco inaczej — patrz str. 625)

Menu - stad otworzysz
obraz do edyc;ji

File Xtns Help

Bi=1ES

o e
L AR

SERA

Paleta narzedzi do
edycji obrazu

(przybornik)

Aktualne  ustawienia
wybranego narzedzia

Wyb6r aktualnej barwy
(pod spodem - barwa tta)

Wyb6r rozmiaru i postaci
"narzedzia”

SzczegOty pracy z warstwami

Rysunek 11.2.2 GIMP (2.4) — okno gtéwne

Wszystkie programy w tej ksigzce pokazuje w wersji anglojezycznej. GIMP ma takze dobre ttumaczenie na
jezyk polski. Jezeli bedzie Ci tatwiej, mozesz podczas instalacji wybraé polskg translacje. Mozesz takze ze

strony Gimpa pobra¢ plik polskich podpowiedzi/opiséw! (Patrz str. 619 i dalsze)
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624 SzczegOly obstugi programow
. P40-org-ver.tif-1.0 (grayscale, 1 layek’l 2480x... | Dodatkowe menu -
File Edit Select Wiew Image Laver Qolors Tools  Dialogs  Filkers operacje thyCZace
tylko tego pliku
A I A e e P | @
1L 1
i : !
3l y i
1 | |
"Linijki": pozioma i 1 |
pionowa — ] i i
A = |
1 q — i
0 1 (o f 1
0 I - !
(I : - 1 1
A o . _ AT |
1 ! = g
1 | e e
1 i
! .- I
vu I e, |
0] i —
0 —=|
i |
i . I
1 =Y
| s I
Tu mozesz & i i !
zmieni¢  powiek- 8 a
szenie 0] | LI
= ! } Informacja o rysunku
b +f[(@ doktadniej - o
] rd aktualnej warstwie)
Ipx b | 13% » g[Background (38,7 ME)

Rysunek 11.2.3 GIMP - zatadowany obraz (drugie okno

W GIMP kazdy obraz umieszcza w odrebnym oknie. Bedziesz wiec miat zawsze obok siebie: okno gtéwne
(palete narzedzi) oraz okno obrazu . Umies¢ je na ekranie tak, aby wzajemnie sobie nie przeszkadzaty.

Dialags

Filters

Paint Tools
Transfaorm Tools
Color Tools

Paths

ection Tools

I
f Color Picker
& o

Te ikony
dziesz takze
przyborniku,
oknie gtéwnym

#
A

znaj-

w

Ellipse Select

Free Select

Fuzzy Select

By Colar Select

Foreground Select

Intelligent Scissors

Shift4+0

u

1

w

Toolbo:x
=, Default Calors

A, Swap Calars

Ctrl+B
o]

k4

Rysunek 11.2.4 Menu Tools

(okno obrazu)

W GIMP polecenia z palety narzedzi (przybornika), sg dostep-
ne takze w oknie obrazu, poprzez menu Tools (Rysunek
11.2.4). Sg w nim pogrupowane w kilka submenu: Selection
Tools, Paint Tools , Transform Tools . W tekscie ksigzki fa-
twiej i bardziej jednoznacznie jest mi podawac¢ polecenia z
menu, niz umieszcza¢ obrazki ikon do naci$niecia. Bede wiec
powotywat sie na nazwy polecen. Jezeli wolisz korzysta¢ z
przybornika - otwérz tylko raz podane przez mnie menu, aby
upewni¢ sie o ktérg ikone chodzi. (Sg zawsze widoczne obok
napiséw) Gdy juz bedziesz wiedziat - uzywaj ich z przybornika.

W dalszym tekscie tego rozdziatu, wszystkie nazwy polecen sg poleceniami z menu okna obrazu. Gdy

bedzie chodzito o menu okna gtéwnego, wyraznie o tym napisze. Dla GIMP w wersji od 2.6 to rozr6znienie
nie istnieje — nie ma innego menu, niz menu obrazu.
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11.3 GIMP 2.6 — r6znice

W nowej wersji GIMP — 2.6 —ulegt zmianie uktad okien (Rysunek 11.3.1):

= GNU Image Manipulation Program E||E|IZ| P |
Eileﬁ Select  View Image Laver Colors Tools  Filkers  Windows Help M
= Menu File zostato przenie-
: X o
E 2 A Qﬂ sione w to miejsce
&S Q ®
% e v [orop image files here to open them]
i Przybornik ) Okr;o z
ﬁ Ez — Wt dodatkowymi
wersji  bez zaktadkami
g menu
O 1|k =
o
A &SR
& 6 of o+ 8 &
% DI 3
Okno obrazu - teraz
X L Brush
| —I stato sie takze gtow- '.'us o 3
Gl (1) (17 & 13
. nym oknem programu :
Paintbrush (= \
Made: !Non‘nal b g ) /__ /J
Opacity! - j i o0,0 | rl : . .
.l____ Fl Fl Fl F) F]
Brush: n Cirele (11)
|crletty | e o ® O O
Y | 4 4 4
Scale: —j— Lo 2
~ -
Brush Dhynarnics . a 4 4 i B
I:‘ Fade out ® . L . -
[ apply Jitter AT
- #
! a >< 4 ><J 4
[] tneremental L el b,
[
I:‘ Use colar from gradient Spacing: J- |_2IJ_,EI_I:
; F =
=] & I Eij | =

Rysunek 11.3.1 Nowy uktad okien w GIMP wersji 2.6

Teraz okno obrazu pojawia sie od razu, zaraz po uruchomieniu programu, gdy jeszcze nie zostat zaladowany
zaden nowy plik. Menu File przesunieto z okna przybornika (por. Rysunek 11.2.2, str. 623) do okna obrazu. Od
tej chwili GIMP ma tylko jedno menu rozwijalne. Tym niemniej wszystkie polecenia, jakie opisuje Rozdziat 2
("Przygotowanie rysunkéw samolotu") pozostajg takie, jakie byty. Po prostu pamietaj, ze teraz menu File jest w
nowym miejscu (a wraz z nim wszelkie polecenia typu File 2Save, File 2Open,..).

Dodatkowe okno po prawej (Layers, Channel, ...) mozesz w kaz-
dym momencie zamknagé, jezeli bedzie Ci brakowaé¢ na ekranie
miejsca.

W oknie Toolbox mozesz umieéci¢ wszystkie potrzebne zaktadki.
Stuzy do tego menu, otwierane w kazdej zakladce za pomocg

matej strzalki (Rysunek 11.3.2).

Polecenie Close Tab zamyka aktualng zaktadke.

=il

di
P

(]

¥ Show Button Bar

[+ Pressure sensitivity

[] Fade out

[] apply Jitker

(@]

Ii< |

|

L
P ik k (9)
M i‘,l Tonol Opkions Meru 3 R.
fdd Tab Al | .

Kliknij w te strzalke,
by otworzyé menu
sterujgce zaktadkami

Rysunek 11.3.2 Przycisk zarz adzajacy zaktadkami
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Zajmijmy sie jednak poleceniem Add Tab. Jest to zagniezdzone menu, prezentujgce do wyboru wszystkie do-

stepne zaktadki (Rysunek 11.3.3):

“* Toolbox B|E|FZ| ,:”.

Fil=  Edit Wiew Image Layer Colors Tools  Filkers  Windows Help
| . ™f
.f%
bl
L& %
R
i |E| Tool Options
[ f@ Device Status
E _=_ Lavers
s Channels
Fi Paths
= Colormap
- | [ka] Histogram
R 1T T |
E] Tl Options Meru y | 1 Selection Editer
Add Tab 3 Mavigation
# Close Tab @) Undo Histary
e e
. " 3 Pointer
Lock Tab to Dock .
| | %y Sample Points
v Show Button Bar |
| ESES— | ™ Calors | - -
[ Fade out < Woybierz stad jedng z
] | | dostepnych zaktadek
[ Apply diner 8L Patterns  [Open the brushes dialog
D Incrernental m Gradients Brese Fi for more Befp
I:‘ Uze colar from gradient H} Palettes
[ & q [ Fonts =
\ [ Buffers

Rysunek 11.3.3 Dodawanie do przybornika dodatkowej

Wyhierz z tego menu jedng z zaktadek (np. Brushes — ksztalty narzedzi). Zostanie dodana w ten sposéb do

przybornika (Rysunek 11.3.4):

][]
Brushes 4

il (1) (17« 13)

EAEy:D)

\
rd
a4 ]
/ / Fl 2
4 a 4
. L]
J a i
s o @
J J
& A& A o)

zaktadki

Dodana zaktadka

Configure this tab

Rysunek 11.3.4 Dodana zaktadka Brushes .
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W ten sposéb mozesz w przyborniku skompletowa¢ wszystkie zaktad-
ki, ktére sg Ci potrzebne do pracy. Wydaje mi sie, ze do naszych celow
wystarczg trzy: Tool Options, Brushes i Layers (Rysunek 11.3.5).

Dokfadnie tak samo mozesz dobiera¢ zaktadki we wczesniejszym
GIMP 2.4. Mozesz w nim takze otworzy¢ zakladke jako oddzielne
okno. (Stuzy do tego polecenie Detach Tab z menu rozwijalnego za-

ktadki — Rysunek 11.3.2).

- Toolbox

Do Y el s
QA+ r28EBRA
HBACEHZ /0 £a
& 8Y oo

- pr—
=l DE=]

Layers )

|

L & B [ u &

Rysunek 11.3.5 Przybornik z wybranymi

zaktadkami
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11.4

Otwieranie pliku (obrazu)

Aby otworzy¢ obraz, wybierz z menu polecenie File 2Open
(Rysunek 11.4.1).

Spowoduje to pojawienie sie okna dialogowego wyboru pliku

(Rysunek 11.4.2). Okno to nie przypomina standardowego okna

Windows. Dzieje sie tak dlatego, ze GIMP (a takze Inkscape)
uzywajg do obstugi okienek zestawu komponentéw o nazwie
GTK+'. Tak wtasnie wyglada w GTK+ komponent do wyboru

plikow.

Tu mozesz
wpisa¢ recznie
nazwe pliku

Lista folderéw/
dyskow

Rysunek 11.4.2 GIMP - okno wyboru plikéw

Atns  Help

CEX

[

Open Location...

Open Recent
Acquire

B Preferences

i Kevboard shorkouts

& Units

Dialogs

# Quit

chrleM [ &h} a/ ':%
Chrl+0 b E] A [Kg [|
NS N

s

Chrl+0

Rysunek 11.4.1 Otwarcie istniej

acego obrazu

_ El_: witold. jaworski ]

Aktualna $ciezka.
Mozesz  przejs¢ do
folderu nadrzednego,
klikajac w odpowiedni
przycisk

Moje dokumenty ” Prywatne || Model [ Rewsunki IAJPress
Places Mame ¥ | Modified ’F‘rg\fiew
T[S witold. jaworski | AJ-P40B-Back.tif 2008-08-19
|2 Desktop =] AJ-P40B-Bottom, HF 2005-08-19
e =) AJ-P40B-Frart.tif 2005-08-19
&0 =] AJ-P40B-Left tif 005-08-1

=% Metwork, Drive (G4
== Mebtwork, Drive (H:\)
=% Metwork, Drive (134}
=% Mebwork Drive (K:\)
= Mebwork Drive (0l)

=% Mebwork, Drive (R:)

= P.J—P‘}DB—Left-E.N

Pliki w aktualnym

folderze
=] AJ-P40B-Right, HF
& A1-P40B-Top. ki 2008-08-19
& P40-org-fre. ki 2008-08-18

B P40-org-LT.iF
#| P40-org-RE,HF

2

2008-08-19

Wt

PAOorgLTE N\ [ dgiad podswie-

745 KB '
30 % 3437 pirels tlonego pliku

Indexed, 1 layer

! Al images
L

| Click ko update preview
Ctrl+Click ta Farce update even if preview is up-to-date

1+ Select File Type (Automatically Detected)

2

2

==

GIMP rozpoznaje wiele ro6znych formatéw zapisu obrazu. Po nacisnieciu Open zataduje wskazany w oknie dia-
logowym plik.

! GTK+ jest biblioteka procedur Open Source, pozwalajaca ha pisanie programéw, ktére beda dziataly w wielu réznych systemach opera-
cyjnych, m. in. Linux, Windows, Mac OS. Posiada nawet polskg wersje jezykowa!
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11.5  Zapisanie pliku (obrazu)
Wybierz polecenie File ?Save As (Rysunek 11.5.1):

== *P40-org-ver.tif-4.0 (grayscale, 1 layer) 2472x720

§=8 Edit Select ‘“iew Image Layer Colors Tools Dialogs  Filkers

O mew.. Ctrl+M |.|5W.|.|.|.|?5Q.|.|.|.|1DQU.|.|.|.|12$U.|.|.|,|1§QD,|,|,|,|1T$D,|,|,|,|2WD,|,|,|,|2250,|,.,.,l25q0,.|&9fi
B Cpen... Chrl+0
= Open as Layers, .. Chrl+alk+0

@ Open Location. ..

Open Recent 3
Acquire 3
E save Chrl+35
I As... Shift+Ctr+5
Save a Copy...
Save as Template...
Bl Revert
& Print...
X Close Chrl+y |
X Close all Shif t4+Chrl4+4
@ Quit Chrlg ]
1
|px w || 33% W “Save this image with a different name

Rysunek 11.5.1 Zapisywanie gotowego rysunku pod now g hazwa

Spowoduje to pojawienie sie okna (Rysunek 11.5.2), podobnego do tego, w ktérym wybieralismy plik do zafa-
dowania (por. Rysunek 11.4.2, str. 628 ):

- Tu wpisz nazwe dla nowego pliku. GIMP rozpoznaje
Bl (PagE-J-Lef format zapisu po rozszerzeniu, ktére nadasz!

== Save I[mage §|
|
|

e

[=) Browse For other folders

[ﬂ[u witald. jaworski ][ Moje dokumnenty ][ Prywatne ]@[ Reysunki ]

Flaces Tame ¥ Modified
123 witold. jawiors |5 Blender-wprowadzenis 2008-03-19
|5 Desktop [SYe) 2008-03-08
e 1) Instalacie 2008-03-03
&0 12 Reysunki Today

2% Metwork Drive
2% Metwork Drive
2% Metwark Drive
2% Metwork Drive
2% Metwork, Drivi
2% Mebwork Drivi
22 Mebwork Drivi

2% Metwork Drive

2% Metwork Drive v
| =

1
malhie Za pomoca tych narzedzi ustal folder, f |

do ktérego chcesz zapisac plik

[#l Select File Tvpe {By Extension)

[ Save l [ Cancel

Rysunek 11.5.2 Okno do zapisywania pliku

W oknie Save Image (Rysunek 11.5.2) wybieramy folder, do ktérego zapiszemy rysunek. Wpisujemy takze na-
zwe pliku. Bardzo wazne jest takze wpisanie wlasciwego rozszerzenia pliku — np. .png, .tif, albo .jpg. (GIMP
okresla sposo6b zapisu obrazu na podstawie rozszerzenia pliku, ktére wpiszesz.)
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Na koniec nacisnij na w oknie Save Image przycisk Save. W
zaleznosci od formatu zapisu, ktéry wybrates, GIMP moze jesz-
cze pokaza¢ pomocnicze okno, z dodatkowymi opcjami. Rysunek
11.5.3 pokazuje takie okno dla formatu TIFF. Mozna tu ustali¢

® Save as TIFF (X

Compression

O Mone Wybierz te  opcje
: kompresji obrazu

spos6b kompresji obrazu. Wybieraj zawsze opcje LZW. OEEackBits
() Deflate
(Nie sprawdzatem innych, ale LZW jest bardzo popularng meto- O 2reG

da, i poprawnie wczytuje sie do Blendera.)
Po nacisnieciu kolejnego przycisku Save, nasz rysunek zostanie
ostatecznie zapisany na dysku.

Comment:

Help l [ Save l ’ Cancel

Rysunek 11.5.3 Okno dodatkowe — Szczegoty
zapisu formatu TIFF
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11.6  Kadrowanie obrazu
Wybierz z menu polecenie Tools ?Selection Tools Rectangle Select , (lub nacisnij na klawiaturze E|). Prze-

suwajac myszke z wcisnietym |:[ zaznacz obszar dookota rzutu z boku (Rysunek 11.6.1).

- BIX]
File Edit Select Wiew Image Laver Colors Tools  Dialogs  Filkers
@l.$.|.|.|.|.|1D.'3'3|.|.|.|.|20.D'3|.|.|.|§~ﬁ-iE
D_
1]
01
0
0
L
g Zaznaczony
&l obszar
I
a1
D_
0
3|
A
o
0
e | .
G, 1400 Ipx v” 13% vl[Rectangle: 2512 = 728

Rysunek 11.6.1 Zaznaczenie rzutu z boku

Nastepnie poleceniem Image >Crop to Selection ogranicz caly obraz do zaznaczonego obszaru (Rysunek
11.6.2):

= *P40-org-ver.tif-1.0 (grayscale, 1 layer) 2472x7... [= |[B]fX]
File Edit 3Select Wiew Image Laver ©olors Tools Dialogs  Filkers
e N R on e e e

:LI.I.I.I.D|.

i

||Jx v” 1% v”Background (26,7 ME)

Rysunek 11.6.2 Wyci eta czes$¢ obrazu
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11.7  Linie pomocnicze ( guides)

Linie pomocnicze (guides) stuzg do oznaczenia jakiegos istotnego miejsca, a takze poréwnan.

Aby doda¢ do rysunku linie pomocnicza, "ztap" myszkg (|:[) za linijke, umieszczong ponad obrazem. Trzyma-
jac przez caly czas wecisniety |:[ przesun ja do dotu. Zobaczysz wowczas, ze przesuwasz pozioma linie po-

mocniczg (Rysunek 11.7.1):

== DAQ- 1]l eft.tif-1.0 (grayscale, 1 layer) 2472x728

File Edit Select “iew Image Layver Colors Tools Dialogs  Filkers
3 B P - I I PO L N WP L= P I 1990 .|.|12$UL(9|.|.|"5'?'3.|.|.|.|1759.|.|.|.|2F'$'3.|.|.|.|2259.|.|.||5~'5;--5|E
. e sl —" — A
. ———Tu was’nul I @ !. vy r__\ ;-
- " I o fermal
it Curtiss Tomahawk Il A - f 1] B
= wersja rozpoznawcza, w kadhubie kamera ] | |
5] F 24 o ogniskowej 336 mm. t anteny ¢ |
] .. | trzymajgc weisniety k=, |
0] przesuwaj
4 myszke w doét.
- Przesuwana linia|
5_' pomocnicza
5 o
8 b '_h':.———‘;_'__."-uﬂ"}i ——
ot
1377, 180 ||:l>< i || J3% W |[Add Guide: 186

Rysunek 11.7.1 "Pobranie" linii pomocniczej

Gdzie zwolnisz |:[ ("upuscisz" linie pomocnicza), tam zostanie. Nie jest czescig obrazu. Mozesz jg powtoérnie
ztapa¢ myszka i przesung¢ w inne miejsce. (Jezeli nie reaguje na myszke - nacisnij na klawiaturze E aby

przejs¢ w tryb przesuwania).

W podobny sposo6b pobierz takze kolejne linie pomocnicze, tym razem pionowe, z linijki po lewej stronie obrazu.
Umies¢ je na kluczowych liniach konstrukcyjnych, o ktérych wiesz, ze powinny by¢ pionowe lub poziome
(Rysunek 11.7.2):

Linie pomocnicze, uzywane do spraw- E:':
dzania linii pionowych —

Crtiss Tcmahawk Il A \A

wiarsjs rozpdznawcza, w kadiubse kamera
4 0 ognisfowe] 336 mm,maszt apteny

il

—

B e

- el

Rysunek 11.7.2 Przykltadowe rozmieszczenie linii pom  ocniczych
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11.8  Widok: powi ekszanie, przesuwanie

W GIMP powigkszenie mozna zmieni¢ na dwa sposoby (Rysunek 11.8.1):

szybko i mniej doktadnie: trzymajgc WciéniQty i obracajgc kotkiem myszki (I:[);

doktadnie, ale nie tak szybko: wybierajac z listy u dotu ekranu jedno z predefiniowanych powiekszen,
lub wpisujac nowe za pomocg polecenia Other.. .

== PAQB-JJ-Left.tif-1.0 (grayscale, 1 layer) 2390x720

Elle Edit Select View Image Layer Colors Tools Dislogs  Filkers

®p, W0, O 1S
ae.,,..... ... . Metoda bezposrednia:
j cul|- [

1 . _

1=

Fle Edit Select View Image Layer Colors Tools Dialogs  Filters

L L I I [1ogo I L I [1250 I

Metoda doktadna:

wybierz Other... |

¥ [Bakoround (5.12 18)

== 7oom Ratio

Select Zoom Ratio
PADB-11-Lef - 1

X

. 1 wpisz tu warto$¢

powiekszenia.
=

Zoom ratio: |3

& T

Zoom:

00|

|
|~

Yo

)|

Cancel

Rysunek 11.8.1 Widok: dwie metody zmiany powi

ekszenia (Zoom)

¢ 7 |[paceroun .18 vy

Przesuniecie widoku to ruch myszki z wcisnietym |:[ (Rysunek 11.8.2):

== PAQR-JJ-L eft.tif-1.0 [grayscale, 1 layer) 2390x720

File Edit Select View Colors  Tools  Dialogs

[1000

Image

Layer

(*] i

Filkers

]

Oczywiscie, mozna
takze postuzy¢ sie
naskami nrzewiiania

Gl

hd

o ¥

87% v ”Background (8.18 MB)

Rysunek 11.8.2 Przesuwanie widoku (  Pan)
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11.9 Rysowanie

Rysowanie pokaze na przykladzie "z zycia wzietym"; na pétprzezroczystej warstwie narysujemy ksztatt kadtuba.
Linie rysunku wzorcowego, do ktérego mamy sie dopasowaé, sa widoczne na warstwie lezacej pod spodem

(Rysunek 11.9.5 pokazuje, co ma by¢ narysowane).

Nim zaczniesz rysowac, upewnij sie, ze tryb koloru twojego rysunku jest ustawiony na RGB. W razie czego —

przestaw go w ten tryb (Image *Mode 2?RGB). Inaczej zamiast czerwonego bedzie szary!

Zacznijmy od momentu, gdy warstwy sg odpowiednio ustawione. Przed rozpoczeciem rysowania czesto zmie-

nia sie aktualny kolor. W tym przypadku wybierz czerwony (Rysunek 11.9.1).

Eile

¥tns  Help

Wigcz
rysowania

fﬂaxa&m@a

Lol
Foreground & background colors, The black and whilf
squares reset colors, The arrows swap colors, Click
open the color selection dialog,

kolor czerwony

HTML potation: | FF00R
™

@w————wmm@@m_nl
oid: | @u [ ]
(o= )= J o=

Rysunek 11.9.1 Ustalenie aktualnego koloru

Z palety narzedzi wybierz "pedzelek” (Tools »Paint Tools Paintbrush z menu, albo E' na klawiaturze). Na-

stepnie ustal forme narzedzia (Rysunek 11.9.2), oraz jego rozmiar (Rysunek 11.9.3):

rall | A=y AL AE
Brushes = Paintbrush =
e LA Wybrany Mode: |N0rmal w |
\ ksztaft ; -
. 4 / / 2 d /' 5 ” Opacity: — W_;l;rany :
. ® . . . . . Brush: iCircIe {199 _/ rozmiar (1.5)
4 Fl F Fl |4
v o ® 0.0 O % Seole: - g fENE
= = 4 o o = A7 = [#] Pressure sensitivity
% 4 ><.¢. L '-+ ﬁ+ = 1 \\%‘\ k\\\\\\\\.'. [ Fade out
LY —
ﬁ+ :‘;w: - ] ) o o I:‘ [_J [1 apply Jitter
0 I O v [[] treremental
Spacing: —_I : !_20_0_:: [1 use calor fram gradient
(e )0 )= ) @ L& ] 8 [ 3 ]

Rysunek 11.9.2 Wybor ksztattu "p  edzelka"

W trybie rysowania, gdzie tylko nacisniesz |:[ na rysunku pojawi sie okragta "plama”. Obrysowanie kadtuba

najwygodniej jest wykona¢ za pomoca krétkich odcinkéw linii prostych. Aby zaczaé taka sekwencje, Kliknij [L2]

Wirtualne modelarstwo — wersja 1.0

Rysunek 11.9.3 Ustalenie rozmiaru rysowania
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w naroznik obszaru, ktry chcesz zaznaczyé. Nastepnie trzymajac weisniety [shift], weisnij [, i nie zwalniajac
go, przesun myszke (Rysunek 11.9.4). Widzisz, ze ciagniesz koniec prostej linii? Gdy trzymasz wcisniety [Shift],

GIMP zawsze tgczy aktualne potozenie kursora z koncem ostatnio narysowanej linii. W ten sposéb mozesz
szybko i doktadnie narysowac ksztalt przysziej selekgc;ji.

*P40B-JJ-Top.xcf-1.0 (RGB, 3 layers) 2356x2827

File Edit 3Select View Image Layer Colors Tools Dialogs — Filkers

=] |50

F!-H-h .l L] I

narysowany

[=T=TE

Przesuwaj myszke,  trzymajgc
wcishiety Shiﬁi-ﬁ, !

5 — il | . . ll‘*’

a0s, 1301 |px A || 150% “6?.3 pixels, Click to draw the line (Ctrl For conskrained angles)

Rysunek 11.9.4 Rysowanie prostymi odcinkami

"Ciggnieta" w ten sposob linia zakonczy sie tam, gdzie zwolnisz . Po obrysowaniu ksztaltu nalezy zamalo-

wac wnetrze obszaru (Rysunek 11.9.5):

Rysunek 11.9.5 Do wypetniania wn etrza wygodniej jest zmieni € rozmiar narz edzia na wi ekszy

Jezeli pomylisz si i narysujesz cos, czego nie powinienes - uzyj polecenia Edit Undo ([ctiHz)).

e Jezeli na rysunku masz juz zaznaczony obszar selekcji — GIMP pozwoli Ci rysowa¢ tylko wewnatrz tego
obszaru. Mozesz go wiec wykorzystywac¢ do celowego naktadania ograniczen (np. aby na pewno zadna li-
nia nie wystawata poza zatozony obrys).
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11.10 Usuwanie fragmentoéw obrazu

Do usuniecia czego$ z obrazu stuzy "gumka": Tools ->Paint Tools 2Eraser . Znajdziesz jg takze w oknie przy-
bornika, pod odpowiednig ikong (Rysunek 11.10.1). Mozesz takze skorzysta¢ ze skrotu na klawiaturze: -.

Po wybraniu narzedzia, wybierz jego ksztalt z zaktadki Brushes . (Rysunek 11.10.1). W zaktadce opcji narzedzia
ustal rozmiar (Rysunek 11.10.2), a potem zaczynaj usuwaé (Rysunek 11.10.3).

=03 =GP EEX
File ¥tns Help Eile  ¥tns Help
L ngcz tryb =T | ég & 3}1 / "5_-;'; ﬁg%
usuwania... - "
— ] 4R BRAEACAD
B e w SO LasBYs 9 d
S
2. Wybierz : a_l
o@D = S I | |navicksze Ol & M
=l olo Lol Sli=g —
rushes Eraser =
Bavde (793 {28 % 27} / I 1
' ’A_/L /é g ‘., . Opacity ;- o
l‘.é.ﬁ.‘.“.& , ’4 Erush: i ‘
. « e ® @ ® @ ox St 'A[EE,L
4 4 4 ".‘ o A iy 4 [#] Pressure sensitivity
X, B LAY
“ - Bl Ustaw odpowiednig
ﬁ+ 90 00 N skale
o o e
= m— [] Hard edge
Spacing: —_} |20 [T [] ntierase calt)
(2 Jolts ) s [ = ] C @ ] @& s (@ Jf
Rysunek 11.10.1 Wybér narz edzia ("gumki") i jej ksztattu Rysunek 11.10.2 Wybér rozmiaru gumki

Teraz juz mozesz wymazaé z rysunku to, czego nie ma na nim by¢ (Rysunek 2.1.4):

= *P40_org-ver.tif-4.0 [grayscale, 1 layer) 2472x720 =S
File Edit Seleck VWiew Image Layer Colors Tools Dialogs  Filkers
|.|.|.|U.|.|.|.|.|25Q.|.|.|.|5W.|.|.|.|75Q.|.|.|.|1QQU.|.|.|.|12$U.|.|.|.|15QU.|.|.|.|1?$U.|.|.|.|2W0.v.|.|.|2250.|.|.|.|25QU.||i§i
(2 . e T e ey Sp—= ["_ e e R e [ B
] 1 SR — — |
] ] Curtiss Tomahawk Il A "\\
] : wiersja rozpoznawcea, w kadhubie kamera
] ' F 24 o ogniskowe] 356 mm,maszt anteny
7] | =
5 i — =
0] f Al
. | = oo S B
E a1 Messsssll
1 i MW
A e
5 I =
H Tu pojawiajg  sie
=t podpowiedzi do tego, I
i . . =
5] co aktualnie robisz! GIMP zmienia kursor
L w svmbol aumki
b 2
2097, 684 |px b || 3% W ”Click to erase (try Shift For a straight line, Ctrl to pick a background color)

Rysunek 11.10.3 Wymazywanie z rysunku niepotrzebnyc  h elementéw

Gumka $ciera, gdy trzymasz wcisniety |:[ (Ta zasada obowigzuje w Gimpie dla kazdego narzedzia: pedzla,

aerografu, itd.). Jezeli pomylisz sie i zetrzesz co$, czego nie powiniene$ - uzyj polecenia Edit ?Undo -.

e Jezeli na rysunku masz juz zaznaczony obszar selekcji — GIMP pozwoli Ci usuwa¢ obraz tylko wewnatrz
tego obszaru. Mozesz go wiec wykorzystywaé do celowego naktadania ograniczen (np. aby na pewno nie
usung¢ niczego wiecej).
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11.11 Zmiana rozmiaru obrazu

Aby zmieni¢ rozmiar obrazu (np. powiekszy¢), uzyj polecenia Image »Canvas size... W oknie dialogowym,
ktére sie pojawi (Rysunek 11.11.1), roztagcz powigzanie pomiedzy wysokoscig i szerokoscig (przycisk z "ogni-
wami"). Potem np. zwieksz wysokos¢ (Height ).

“® Set Image Canvas Size El
[H,  Set Image Canvas Size
.= P40-org-RB £iF.5 L
1. Kliknij tu, by rozigczy¢
Canvas Size zmiany  wysokosci i
o) &
widkh: |z400 .: H szerokosci
- Heioht: 1300 |3 B | piels v |
2. - RN S 1
Tu V’VPISZ nowa 2480 = 1300 pixels
wysoko$¢ 200 ppi
Offset
|0 .
4R 5362 I: | pixels VI [ Center
T | |3. Ztap i przesun D) miniature
nowa T paa . / rysunku, dopasowujac do nowego
wysokosé stara o Ly & X obszaru
l Wysokos¢ = ‘i’ %
Layers
Resize lavers: !AII lavers vl
¥ 4. Wybierz z listy wartos¢
’ Help ] l Reset l I Resize Alllayers

Rysunek 11.11.1 Okno zmiany rozmiaru obrazu
Nastepnie przesun (|:[) miniature aktualnego obrazu do dotu, aby przestrzen, ktérg dodajemy, znalazia sie u

gory. Gdy skonczysz, nacisnij przycisk Resize.

Na koniec nie zaszkodzi wywota¢ polecenie Layer >Layer to Image Size . Co prawda nie uzywamy w tym ry-
sunku warstw (layers), ale GIMP traktuje catg zawarto$¢ obrazu jako pojedyncza, domysing warstwe.
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11.12 Dodanie warstwy (z innego pliku)

Wczytamy zawartos¢ drugiego pliku jako dodatkowy obraz, do nowej warstwy. Zazwyczaj chodzi o to, aby nato-
zy¢ na siebie obydwa rysunki, i je poréwnaé. W tym celu po wczytany obraz uczynimy czesciowo przejrzystym.
Aby taki efekt byt mozliwy, aktualny rysunek nie moze zapisywaé barw jako tzw. indeksowanych koloréw. Jezeli
w menu Image ?Mode zobaczysz, ze twdj rysunek ma wiaczony tryb Indexed, musisz to zmieni¢. Najlepiej
bedzie, jezeli wywotasz polecenie Image *Mode >Grayscale , To zmieni odwzorowanie barw na 256 odcieni
szarosci. Mozesz takze przetaczy¢ sie w tryb barwny — Image 2Mode 2RGB,,.

Nastepnie zataduj zawarto$¢ drugiego pliku z obrazem jako nowej warstwy: File 2Open as Layers . W oknie
dialogowym wyboru pliku znajdz i wskaz obraz — powiedzmy, ze nazywa sie P40B-JJ-Left.tif .

W efekcie zobaczysz w oknie obrazu obydwa rysunki. Wczytany obraz przykryt dotychczasowy (Rysunek
11.12.1):

CEX

BN “P40B-JJ-Right.tif-23.0 (grayscale, 2 lay... [= |[3][X]

Eile #tns Help

File Edit Select Wiew Image Laver Colors Tools Dislogs g i G Wi B )
o oy oy Oy e 2008 .|q- ] R ®E ao & ﬁi ‘/ fe &
U Fos B -
_ s8R ACEACKE
! D AEERY U
0| prmset T Zmiana przejrzysto-
1 ¥ B $ci pod$wietlonej
1. —#m_\ warstwy —\
1 Il 1 =
! PN BICTIEr am
P Layers \ @
E [ . E : Mode: iNormaI & hd |
i | Zatadowany, dodat- ; T ;
= kowy rysunek jest na ]| 10,0 &
0OH wierzchu
0
o
- ] P4E- T Lottt

Dodatkowo mozesz zablo-
kowa¢ przypadkowe zmia-
ny w nowej warstwie...

- Background

Oryginalna  (domysl-
] na) warstwa jest pod
= spodem

+

|p>< v|| 13% v;P4DB-JJ-LeFt.tiF(2?.9MB) E & [I] &

Rysunek 11.12.1 Dwie warstwy rysunku, ka zda z sylwetk 3 samolotu

Otworz w przyborniku zaktadke sterujgcg warstwami (Layers - Rysunek 11.12.1). Wida¢ tu liste z dwoma wier-
szami. Kazdy z nich to jedna z warstw. Dotychczasowa zawarto$¢ rysunku znajduje sie na warstwie
Background . (To domys$lna nazwa warstwy w GIMP). Druga warstwa nosi nazwe wczytanego pliku. Efekt "na-
lozenia" obydwu rysunkéw na siebie wzigt sie stad, ze warstwa P40B-JJ-Left.tif znajduje sie powyzej warstwy
Background , i po prostu jg zastania.
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Teraz zmienimy przejrzystos¢ warstwy P40B-JJ-Left.tif . Upewnij sie, ze jest pod$wietlona na liscie Layers
(oznacza to, ze jest aktywna). Nastepnie zmien warto$é, ustawiong na suwaku Opacity, z 100 na 40 (Rysunek
11.12.1). Zobaczysz, ze spod spodu zaczng "przeswitywac" linie warstwy Background (Rysunek 11.12.2).

BB *P40B-JJ-Right.tif-23.0 (grayscale, 2 layers) 24B80x1300

ile  Edit Select  Miew Image Layer Colors  Tools Dialogs  Filkers

n

|I|I||SD|DI|I|I|I||1D|DDI|I|I|I||15|DDI|

=l

Sl

DDU\l

e

ipx Vi 25% V|[P4DB-JJ-LeFt.tiF {27.9 MB)

Rysunek 11.12.2 Efekt wt gczenia przejrzysto $ci na gornej warstwie obrazu
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11.13 Dodanie warstwy (pustej)

W wyniku polecenia Layer New Layer pojawi sie okno dialogowe
New Layer (Rysunek 11.13.1).

W polu Layer name wpisz nowa hazwe warstwy. Sposrdd grupy opcji
Layer Fill Type wybierz sposob wypehienia tta warstwy. Zazwyczaj
wybieram tlo w pelni przejrzyste (Transparency ).

Po nacisnieciu OK nowa warstwa zostanie stworzona.

Wirtualne modelarstwo — wersja 1.0

Create a New La

=

Whpisz nazwe

£

Laver name: iMask| I

width:
Height:

Layer Fill Type

[

EEEl

|

() Foreground calar

Pozostaw wypetnienie
transparentne

|

| [ e

Rysunek 11.13.1 Tworzenie nowej warstwy
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11.14 Warstwy — zarz gdzanie

Warstwy w GIMP mozesz sobie wyobrazié, jako oddzielne powierzchnie przejrzystej folii. Kazda z nich moze
zawiera¢ oddzielny obraz. Obrazy te nakladajg sie na siebie (Rysunek 11.14.1). Do zarzgdzania warstwami
stuzy zaktadka Layers, dostepna w przyborniku.

BN “P40B-JJ-Right.tif-23.0 (grayscale, 2 lay... [= |[3][X]
File Edit Select Wiew Image Laver Colors Tools Dislogs Eile #tns Help

LIPS L1 WP T O - L ST £
e | 1 | | | 1 L | £y %;&

ol }
|+ [ @l = Bl oo

&
A

Lavers =
r
o Warstwa o nazwie[ode: | Marmal v|
: P-40-JJ-Left.tif T | oo |,
0

i k. .1

lack: [

_ o] 1B oe i
| = < Background
_ Warstwa 0 nazwie Dal

Background
(D) « (& )& ) &

J1-Left.bF

|p>< b || 13% » |[P4DB—JJ-LeFt.tiF (27,9 MB) |

Rysunek 11.14.1 Warstwy — na obrazie i w zakladce Layers

Zaktadka Layers zawiera liste warstw, oraz kilka pomocniczych kontrolek. Rysunek 11.14.2 wyja$nia, jak sie nig
postugiwac:

(o (oW s ] |
+ @l = &l i
\Tryb mieszania" z pozostatymi warstwaml‘
Layers f 5 -
Tu Kliknij, aby zabloko- A Regule}qa nieprzej
waé lub odblokowaé Mode: |N0rma| w | rzystosci  (Opacity)

mozliwo$é zmiany g I IR J aktualnej warstwy
obrazu na tej warstwie Rty a2
s O] 8

Aby  zmieni¢  kolejno$¢

Tu kliknij, aby ukryé lub
pokaza¢ warstwe

warstw, ztap ) jedng,

z nich i przesun w nowg
pozycje

v

Rysunek 11.14.2 Funkcje zaktadki Layers

Warstwy moga zastaniaC sie wzajemnie. Jak w Swiecie rzeczywistym, obowigzuje zasada, ze warstwa lezgca
wyzej zastania warstwe lezaca nizej. Stad, w przykiadzie na ilustracji (Rysunek 11.14.1), warstwa P-40-JJ-
Left.tif zastonita obraz na warstwie Background . Te nieprzejrzysto$¢ mozna jednak zmniejszy¢. Stuzy do tego
suwak Opacity , umieszczony powyzej listy warstw (Rysunek 11.14.2).

Kolejnosé warstw takze mozna zmieni¢ — wystarczy "ztapaé" pojedynczy wiersz |:[ i przesung¢ w nowe po-

lozenie na liscie (Rysunek 11.14.2).
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Warstwa moze by¢ zablokowana . Na zablokowanej warstwie nie mozna niczego rysowac¢, zaznaczac, ani w
zaden inny sposéb usuwaé zawartego na niej obrazu. Do wigczenia/wytgczenia blokady stuzy ikona "fancucha”,
po lewej stronie nazwy warstwy (Rysunek 11.14.2).

Wreszcie — warstwe mozna ukry €. Stuzy do tego ikona "oka", umieszczona z lewej strony nazwy kazdej war-
stwy.

Aby zmieni ¢ nazw e warstwy — kliknij w nig dwukrotnie. W wierszu pojawi sie chwilowe pole edycji, w ktorym
bedziesz mogt jg poprawié.

Na koniec moze wyjasnie, pochodzenie nazw warstw w tym przyktadzie:

Background — jest to warstwa domys$ina. Taka warstwa istnieje w kazdym obrazie, otwartym w GIMP.
(Chyba, ze jg usuniesz i zapiszesz catos¢ w natywnym formacie tego programu, czyli
xcf.)

P40B-JJ-Left.tif — warstwa powstala poprzez wczytanie dodatkowego obrazu (File 2Open As Layer).

GIMP nadaje w takim przypadku nazwe wczytanego pliku.
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11.15 Usuni ecie warstwy
Warstwe mozesz usuna¢ na dwa sposoby: T T2
Mo =y Fim
Layers =

1. Poleceniem Layer Delete Layer. Usuwa aktualng
warstwe (zawsze sie upewnij, ktéra jest aktualna...)

2. W zakladce Layers: Podswietl wiersz, odpowiadajacy
warstwie, ktora chcesz usung¢é. Nastepnie nacisnij
przycisk z ikong kosza (Rysunek 11.15.1).

Mode: | Morral

bl

Opaciky:

lock: [ .

1000 |y

(D)L= ] @

Podswietl te warstwe

2 Backgrdund nacisnij ten przycisk

fe 023 Lot v

D

Rysunek 11.15.1 Usuwanie warstwy (zakladka Layers)

Copyright Witold Jaworski, 2009 - 2011.



644 SzczegOly obstugi programow

11.16 Zaznaczenie obszarem prostok atnym

Zaznaczanie obszaru selekcji za pomocg prostokata jest w GIMP najprostszg formg selekcji. Nacisnij na klawia-
turze klawisz E lub wybierz z menu polecenie Tools »Selection Tools —*Rectangle Select :

1.Tu wcisnij D by \///\
wskazac poczatek ( ol

prostokata {_—”
Yannn |
r_.___

s 2. Trz majap wecisniety
d, przesuwaj myszke

3. Tu zwolnu D — by zazna-

~y czy¢ krance wybranego obszaru

Rysunek 11.16.1 Zaznaczenie obszaru selekciji

Rysunek 11.16.2 pokazuje wybrany obszar. Nadal mozna go jeszcze zmieni¢ (powiekszy¢, pomniejszy¢). Stuzg
do tego uchwyty w naroznikach obszaru. (Sg tak duze, ze trudno ich nie zauwazyé¢:

Za te uchwyty mozesz "ztapac¢"
) myszki i przeciagna¢. To

najszybsza  metoda  zmiany
obszaru

Rysunek 11.16.2 Prostok atny obszar wyboru

Aby wylgczy¢ obszar selekcji — wystarczy wywota¢ polecenie Select ?None.
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11.17 Zaznaczenie obszarem nieregularnym
Narzedzie dla ludzi o pewnej rece! Wybierz polecenie Tools Selection Tools Free Select (lub |F| z klawia-

tury). Zacznij rysowac zamkniety obszar (Rysunek 11.17.1):

n
\\ 1. Tu zaczynasz

- naciénijl | _./_756—" L " .
i m : Sl o Torwa 1k -

i

2. Rysujesz, trzymajgc

/ wcisnigty D

Rysunek 11.17.1 Rysowanie granic obszaru selekcji

Obszar po zamknieciu jest obrysowany linig przerywang (Rysunek 11.17.2):

Rysunek 11.17.2 Przykitad nieregularnego obszaru sel  ekciji

Aby wylgczy¢ obszar selekcji — wystarczy wywota¢ polecenie Select ?None.
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11.18 Zaznaczanie — wg wskazanego koloru

Wywotaj polecenie z menu: Select 3By Color (shit}{o]), albo nacisnij przycisk z przybornika (Rysunek

11.18.1a):
1. Wiacz tryb Select By
Color ‘ Eiﬂilﬂ)
f 2. Wskaz kolor, Zaznaczone obszary

ktory ma byé (bez krawedzi)

2 Py s ‘ .
@ A ‘
SERA & (
ON 14 l
8 & 8 g T T

e B By

1 1

I '

Rysunek 11.18.1 Zaznaczenie poprzez wskazanie kolor u

Nastepnie kliknij ) w obszar o odpowiednim kolorze (Rysunek 11.18.1b). W efekcie na rysunku zostanie

zaznaczony kazdy piksel o wskazanej barwie. Zwr6¢ uwage, ze czarne krawedzie siatek nie zostaly zaznaczo-
ne (Rysunek 11.18.1c).
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11.19 Zmniejszanie/zwi ekszanie obszaru zaznaczenia

Aby poszerzy¢ obszar selekcji, wywotaj polecenie Select 2Grow... (Rysunek 11.19.1):

Ciemne  krawedzie
g ey nie sa zaznaczone

Tu ustalasz, o ile
chcesz poszerzy¢
obszar selekgcji

= Grow Selection
Growy/selection by
“| pixels w | |":|

Q i :

| [ Help H 074 ” Cancel l I 5

.,______

ek ---==-==

= Wocigcie w
: zaznaczeniu

| b
r

Rysunek 11.19.1 Poszerzanie zaznaczonego obszaru (p  olecenie Select 2Grow...)

W oknie dialogowym Grow Selection (Rysunek 11.19.1a) ustal rozmiar powiekszenia (w pikselach) i nacisnij
OK. Czasami, gdy krawedz biegta na brzegu obszaru, mogg tam pozosta¢ wciecia (Rysunek 11.19.1b). Takie
miejsca trzeba zaznaczac¢ recznie.

»  Odwrotng operacjg do Select 2Grow jest Select 2Shrink : zmniejsza obszar zaznaczenia
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11.20 Zaznaczanie — narysowanym obszarem

W GIMP obszar selekcji moze by¢ dowolng plama/plamami. Moze takze mie¢ rozmyte krawedzie. Takie efekty
mozesz uzyskac tylko w jeden sposob: malujac obszar selekcji, tak jak maluje sie jakis ksztalt.

*  Narysowanie obszaru selekcji nie zadziata, jezeli rysunek jest zapisany w trybie tzw. indeksowanych barw.
Aby mie¢ pewnosc, ze wszystko bedzie poprawnie, przetacz go w tryb RGB (Image Mode 2RGB)

Pokaze, jak to zrobi¢ na przyktadzie opisanym w pierwszej czesci tej ksigzki (str. 47). Chodzi o objecie Scisle
"przylegajacy” selekcja rysunku tylnej czesci kadtuba samolotu. Linie rysunku znajdujg sie na warstwie o nazwie
Background.

Obszary selekcji bedziemy malowa¢ na oddzielnej warstwie, ktérg stworzymy wytacznie dla tego celu. Wywotaj
polecenie Layer ?New Layer. Dodaj do rysunku na nowg warstwe, o nazwie Mask (szczegdly — str. 640).
Warstwa musi by¢ zupetnie przejrzysta. (Podczas tworzenia, w oknie dialogowym New Layer, okresl| kolor tta
jako Transparency ).

Rysunek 11.20.1 pokazuje, jak nalezy przygotowa¢ ukiad
warstw (szczegoty - str. 641): 4 @ .]; = g o [
| | | = -

- Zablokuj wszystkie inne warstwy, poza Mask. (Bedziemy ry- | Warstwa ze wzorem —
L. . . . i |Layers do obrysowania @ |
sowac, wigc chodzi o to, by to robi¢ wytgcznie na warstwie g Normal 2 |
Mask .); :Opacitv: J !IEIEID__: Tl

- Ukryj wszystkie inne warstwy poza Mask i Background ; tock: [ =
- Przesun warstwe ze wzorcem ksztaltu do narysowania — | a DB:ckgmund

Background — ponad Mask; o

X i L, o ! S S Mask — aktywna i jedyna
- Ustaw nieprzejrzystos¢ Background na 50%, by wygodniej nie zablokowana I
dopasowacé rysowany ksztatt do linii kadtuba;

]
- Podswietl Mask, aby stata sie warstwg aktywna. E

Po ustaleniu stanu warstw nalezy na warstwie Mask obrysowaé

i wypehié (szczegbly — str. 634) ksztalt kadiluba (Rysunek Rysunek 11.20.1 Zmienione uporz adkowanie warstw
11.20.2):

P40B-13-Left tif

Pozostate warstwy —D &

ukryte

L\ ) H W ET ]
! i i [E R
=, ﬁ_m | e 1 | Ty | — . - = .
-8 L=
e . ‘f """" =l S L 2 /Fi._
-.—\I.«’-T*‘-“‘-'I?*:—Lbr e “ e

Rysunek 11.20.2 Rysowanie ksztattu selekcji

Wirtualne modelarstwo — wersja 1.0 www.samoloty3d.pl




Rozdziat 11 GIMP — szczegOty obstugi 649

Na koniec zmien narzedzie na "gumke" (Tools Paint Tools Eraser, z klawiatury [shit E]). Ksztatt narzedzia

pozostaw bez zmian, za to rozmiar przestaw na 1.0. Uzyjemy go do drobnych wygtadzen i korekt narysowanego
ksztaftu, np. wymazania naddatku linii (Rysunek 11.20.3).

i l,

|

Wymazany naddatek

.
-
'

o e e

-4

e e e e ED

EH.E = =B

Rysunek 11.20.3 Ko Acowe przygotowania - wymazanie "naddatkow"

Pozostaje zmieni¢ narysowany ksztatt na selekcje. Wywotlaj polecenie: Layer ?Transparency —?Alpha to
Selection .

| to wszystko. Na koniec porzadkujemy warstwy (Rysunek \@|\”ﬁ[§iﬂ§|\“§|

11204) Lavers

- zablokuj i ukryj Mask (mozna by ja bylo usunaé, ale moze |Mede: [Nomal uMkarf,:‘a wytaczona i # |

sie przydaé przy nastepnym takim przypadku); ey D - = =0 | @
Lock:

- odkryj inne warstwy (te, ktére sg potrzebne do dalszej pra- Background ~do-

3 stepne do zmian
Cy); ﬂ MMask

- odblokuj warstwe, na ktérej chcesz co$ zmieni¢ za pomocg
aktualnie wybranego obszaru (np. Background). Podswietl
ja, by uczyni¢ aktywna.

0B-13-Left, Lif

AN Pozostate  warstwy

— widoczne

(D J(e JCo JU =™ T ¢ (8 ]

Rysunek 11.20.4 Przygotowanie warstw

e W GIMP ksztalt selekcji "przenika" przez wszystkie warstwy. Nie jest zwigzany w szczegoélny sposéb z
zadna z nich. Dzieki temu warstwa, na ktorej rysowates ksztalt selekcji, moze by¢ zaraz usunieta
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11.21 Zaznaczenie — poprawianie za pomoc g Quick Mask

W sekcji 11.18 (str. 646) przedstawitem tworzenie zaznaczenia z kanatu Alfa (nieprzejrzystosci) aktualnej war-
stwy. Podobny efekt mozna takze osiggng¢ w inny sposdb — wykorzystujac tzw. ,chwilowg maske” (Quick
Mask) . Jest to metoda bardzo przydatna do obstugi obszaréw selekcji 0 bardzo ztozonych ksztattach.

Rysunek 11.21.1a) przedstawia przyktad skomplikowanego obszaru selekcji. Przetgczymy sie w tryb Quick
Mask, aby go zmieni¢. Mozesz to zrobi¢ na kilka sposobdw: wywolujgc polecenie z menu (Select >Toggle
Quick Mask ), skrétem [shitt o], lub klikajac w lewy dolny naroznik rysunku (Rysunek 11.21.1a):

Zaznaczony obszar jest przejrzysty —
wida¢ pod nim rysunek

Zaznaczony
obszar

ol

el ~

II II Il

- Obszar nie zaznaczony ma
— —/r— czerwong, potprzejrzysta barwe
]

:|'._— === _

|
|
|
|
|
|
/
|

0 tuta,

by przelaczyé sig w /=== . g
tryb Quick Mask Y =N

Aby powrdci¢ do normalne-| | ——

go trybu rysowania —|__— | |
. » - . == = e i
R kliknij Wtuta} =t >

Rysunek 11.21.1 Przet gczenie w tryb rysowania zaznaczenia ( Quick Mask )

Mozesz traktowac¢ Quick Mask jak specjalng, chwilowg warstwe, natozong na rysunek. Zaznaczony obszar jest
na niej zupetnie przezroczysty. Reszta jest pokryta potprzejrzystym kolorem czerwonym (Rysunek 11.21.1b).

. Do przefaczenia sie z powrotem w tryb normalny stuzg te same polecenia (Select 2Toggle Quick Mask

skrét [SiHa).

Po powierzchni chwilowej maski mozesz rysowac, uzywajgc dowolnego narzedzia z przybornika. Rysunek
11.21.2a przedstawia przyktad uzycia pedzelka (Paintbrush ). Rysujac, zmniejszasz obszar zaznaczenia:

__|Po przetaczeniu trybu pracy na| | =
normalny zamalowany fragment
nie jest juz zaznaczony

| |Malujac po masce, zmniejszas:
obszar zaznaczenia

Rysunek 11.21.2 Zmiana obszaru zaznaczenia — poprze z malowanie

*  Aby zwiekszy¢ obszar zaznaczenia, uzyj w trybie Quick Mask ,gumki” (Eraser). Wystarczy usung¢ z maski
kolor czerwony.
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Podczas pracy z maska chwilowg nalezy uwaza¢ na wybieranie narzedzi. Jezeli wybrate$ w trybie normalnym
wybrane narzedzie Paintbrush, i przetaczyte$ sie na Quick Mask, to dalej bedziesz malowa¢ po powierzchni
normalnej warstwy, a nie po masce.

»  Wszystkie narzedzia, ktérych chcesz uzy¢ do zmiany Quick Mask, wybierz po przetaczeniu sie w ten tryb.
Nawet jezeli jest to ten sam Paintbrush, aktualnie uzywany w trybie normalnym — wybierz go raz jeszcze.

Moze to efekt jakiegos btedu w programie i zniknie w kolejnych wersjach — ale przezornos¢ nie zawadzi.
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11.22 Zaznaczenie — zachowywanie obszaru w zakladce  Channels

Czasami najbardziej pracochtonng czescig malowania w Gimpie jest rysowanie odpowiedniego obszaru selekciji
(na przykiad w trybie Quick Mask). Czy mozna taki obszar zaznaczenia zachowa¢ do pozniejszego uzycia? Na
szczescie — tak. Stuzy do tego polecenie Select 2Save to Channel (Rysunek 11.22.1):

Views Image Lawer Colors  Tools

/= oS

X None Shift-+Ctrl-+4 Channels «—— |Zadadke channels] - >3 |
g Irvert Che+I przybornika

= Float Shift+Chri-+L .

"8 By color Shift+c EMRl Creen

b

{7% selection Editor

Feather... — Kiknij [0 i nadaj
= mu dowolng nazwe
s o Alpha

Sharpen

15 ¢ Shrink...
" _a Zapamigtany obszar
Coarow,,, zaznaczenia

& Upper Camuflage|

Border...

Diskart,..
Rounded Pe

Wywotaj Save to Channel‘

Usuniecie zapamietanego
obszaru selekcji

ShiFt+Q Przela@zenie selekcji na
HH zapamietany obszar TN\
| [ « 4 o ¥ @

Rysunek 11.22.1 Zapami etanie obszaru zaznaczenia — do powtérnego u  zycia

Obszary zaznaczenia, zapamietane w zaktadce Channels, sg przechowywane w pliku rysunku i moga byé¢ uzyte
takze po ponownym uruchomieniu programu. Uzyj przycisku, umieszczonego u dotu zaktadki Channels
(Rysunek 11.22.1), aby przeksztalci¢ je z powrotem w aktualng selekcje.

Gdy w zakladce Channels klikniesz [Z2] na jednym z zapamie- B e A e

tanych zaznaczen, otworzysz menu kontekstowe (Rysunek

11.22.2). Znajdziesz tam kilka przydatnych polecen, stuzacych do New Channel...

. . . & Polecenia, okre$lajace
laczenia zapamietanego obszaru zaznaczenia z aktualnym ob- sposéb  polaczenia
szarem selekcji' & obszaru zaznaczenia z

' aktualng selekcja
=) puplicatg Channi

- Channel to Selection oznacza zwykle zastapienie aktu-
alnego obszaru przez obszar zaznaczenia;

- Add to Selection pozwala doda¢ do aktualnie zazna-
czonego na ekranie obszaru obszar zaznaczenia;

- Substract from Selection zmniejsza aktualng selekcje o
obszar zaznaczenia;

- Intersect with Selection zmniejsza obszar aktualnej se-
lekcji do czesci wspblnej z obszarem zaznaczenia

B add to Selection

[ subkract from Selection

Inkersect with Selection

Rysunek 11.22.2 Channels — menu kontekstowe
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11.23 Obrét

Jezeli w GIMP jaki$ obszar jest wybrany (selekcjg) — obrot bedzie dotyczyt tylko tego obszaru. Jezeli jednak nic
nie jest wybrane, obracana jest cata zawartos¢ pierwszej warstwy (tej "najbardziej na wierzchu"). Operacje po-
kaze na przyktadzie wilasnie takiej sytuaciji.

Wywotaj polecenie Tools 3Transform Tools Rotate ([shift}{R]). Pojawi sie dodatkowe okno Rotate (Rysunek

11.23.1). Zauwazysz takze pewne pogorszenie jakosci wyswietlanego obrazu. Linie staty sie mniej gtadkie, gdyz
GIMP przetaczyt sie na wyswietlanie "roboczej kopii" rysunku. Pokazuje teraz, jak bedzie wygladat obraz, gdy
zatwierdzisz ten obr6t. (Czyli gdy nacisniesz przycisk Rotate. Jezeli nacisniesz Cancel - zrezygnujesz z calej

operacji).

File Edit 3Select Yiew Image Laver Colors Tools Dialogs  Filkers

B||||D||||||||||2$Q||||||||5pQ||||||||?5Q||||||||1Dq0||||||||12$D|*||||||15QD||||||||1r$D||||||||2pQD||||||||2250||||||||25qdiq

Curtiss Tomahawk Il A
vadok z praws] Firony

- | To jest znacznik $rodka obrotu.

Mozesz go przesuwac

= Rotate

g B Rotate
o ™ Background-10 (P40-org-RE 1if)
i
I 090909
1| anck: | =
N — {
I] | contersss [1344.00 |2
O | center v: [447.00 ::l px v| | Skl ) |
: l Help l ’ Reset l [ Rotate l l Canicel +

T 111

Rysunek 11.23.1 Okno obrotu obrazu ( Rotate)

Zwrd¢ uwage, ze okno Rotate nie przeszkadza w zmianie powiekszania widoku, ani w przesuwaniu poziomym i
pionowym suwakiem. To bardzo wygodne, gdyz z wiekszg dokladnoscia mozesz obserwowaé zgodnos¢ linii
pomocniczej i linii na kadtlubie samolotu. Podczas obrotu pokazywana jest takze 0$ obrotu — kotko z krzyzy-
kiem, wygladajace jak celownik (Rysunek 11.23.1). Mozesz w kazdym momencie jg ztapac (|:[) i przesungc¢ w

nowe miejsce.

Obraz mozna obraca¢ przesuwajac myszke z wcisnietym |:[ (dobre na pierwsze, duze przyblizenia). Mozna

takze zmieni¢ numeryczng warto$¢ kata obrotu w oknie Rotate, polu Angle (tak najwygodniej wprowadzac
ostatnie, drobne poprawki). Wartos¢ kata w polu Angle zmienia sie takze wtedy, gdy obracasz obraz myszka.

Obrot zatwierdzamy naciskajac przycisk Rotate. Jezeli obracalismy tylko wybrany obszar — po zakonczeniu
obrotu nalezy dodatkowo wywotac polecenie Layer *Anchor Layer , by "zatwierdzi¢" rezultat operacji.
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11.24 Przesuni ecie

Jezeli w GIMP jaki$ obszar jest wybrany (selekcja) — przesuniecie bedzie dotyczy¢ tylko tego obszaru. Jezeli
jednak nic nie jest wybrane, zmianie ulega cata zawartos¢ pierwszej warstwy (tej "najbardziej na wierzchu").

Transformacje zademonstruje na przyktadzie, gdzie przesuwam fragment potprzejrzystego obrazu z gornej (ak-
tywnej) warstwy ponad obraz na drugiej warstwie. (Zostat tam umieszczony jako wzorzec). Na warstwie aktyw-
nej jest zaznaczony prostokatny obszar (Rysunek 11.24.1). Naciénij na klawiaturze E (jest to skrét polecenia

Tool 2Transform Tools Move). "Ztap" zmieniamy obszar ) i przenie$ we wiasciwe miejsce:

Zaznaczony frag-
ment (warstwa
aktywna)

N

£ Ty "Tap” 1LPM' zazna-| \
.\;,‘_ D‘@— =Y czenie i przesun

~ I "
1 I P "
e i 5B o — \|Zarys  obrazu
r ' - / daid: et | I i[na fragmencie
\\—‘ﬁ S Sl B - SESSS———— | 1l do przesuniecia
- I ' i 4 Ik i
| 77 - Bt ' I
! o " " ! |zarys obrazu A
: 5 f : ; : M Pl
: o TSR wzorcowego _ |

Rysunek 11.24.1 Przesuwanie fragmentu obrazu

Przesuniecie konczysz, zwalniajac - (Rysunek 11.24.2):

Fragment po
przesunieciu

Rysunek 11.24.2 Obraz po przesuni eciu

Na koniec wywotaj polecenie Layer 2*Anchor Layer (—. To scali "ptywajacy" ponad rysunkiem, deformo-
wany obszar, z resztg obrazu, i zakohczy catg operacje.
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11.25 Przekoszenie ( Shear)

Jezeli w GIMP jaki$ obszar jest wybrany (selekcjg) — transformacja bedzie dotyczy¢ tylko tego obszaru. Jezeli
jednak nic nie jest wybrane, zmianie ulega cata zawartos¢ pierwszej warstwy (tej "najbardziej na wierzchu").

Transformacje zademonstruje na przyktadzie, gdy wybrany jest prostokatny obszar. Wywolaj polecenie
Tools STransform Tools Shear (lub [shitt}{s]). Pojawi sie dodatkowe okno Shear (Rysunek 11.25.1). Zauwa-

zysz takze pewne pogorszenie jakosci obrazu w zaznaczonym obszarze. Linie staly sie mniej gtadkie, gdyz
GIMP przetaczyt sie na wyswietlanie "roboczej kopii" tego fragmentu. Pokazuje teraz, jak bedzie wygladat ob-
raz, gdy zatwierdzisz te transformacje. (Czyli gdy nacidniesz przycisk Shear. Jezeli nacisniesz Cancel - zrezy-
gnujesz z calej operacji).

| *P40B-JJ-Right tf-23.0 (erayscale, 2 layers) 247)x1300 - [o]x]|
File Edit Select Wiew Image Laver Colors { 1]
B :In | I I |1 TDp TR I AT T G |1 $QD PN B I |21 Dp TR I AT Do G |220p P B I |2$Dp PR BT T |240p I T q'

: ]

=— Zaznaczony obszar

é_' — do deformaciji “

4
greer—n -
i E
1™ -
1 Przekoszenie
5_' §: © |7 '|najlepiej  zmie-| x
il * |nia¢  w  polu :
Oyl ¢ numerycznym i

. Shear
S TR
‘}! Buackground-E5 (P40B-11-Right tif)

Shear magnitude X: h‘

|~ = : &
| e =ir 4
Shear magnitude ¥: |0 |t M

s, oo M e [N cocd ]

Rysunek 11.25.1 Przekoszenie (poziome)

Polecenie Shear dziata podobnie do obrotu. (Zresztg wszystkie transformacje w GIMP dzialajg w taki sposéb).
Obecnos¢ okna Shear nie przeszkadza w zmianie powiekszenia widoku, ani w przesuwaniu pionowym i pozio-
mym suwakiem. Przekoszenie nie ma, niestety, widocznego $rodka, ktéry mozna by byto przesung¢. Punkt ten
jest staty i znajduje sie w srodku obszaru selekciji.

Podswietlony na rysunku fragment mozna deformowac przesuwajgc myszke z wcisnietym |:[ (dobre na

pierwsze, duze przyblizenia). Mozna takze zmieni¢ numeryczng wartos¢ transformacji w oknie Shear, polu
Shear magnitude X (Rysunek 11.25.1) (tak najwygodniej wprowadzac ostatnie, drobne poprawki). Warto$¢ w
polu Shear magnitude X zmienia sie takze wtedy, gdy dokonujesz deformacji myszka. Przekoszenie zatwier-
dzasz naciskajgac przycisk Shear.

W zwigzku z tym, Zze nie masz wptywu na polozenie osi, po transformacji zmieniony fragment lezy niezupetnie

tam, gdzie trzeba. Po zakonczeniu przekoszenia zazwyczaj musisz go dodatkowo przesung¢ we witasciwe miej-
sce.
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Nacisnij na klawiaturze E (jest to skrét polecenia Tool 2Transform Tools >Move). "Ztap" zmieniamy obszar
(T2 i nasun na linie obrysu widoczne pod spodem (Rysunek 11.25.2,Rysunek 11.25.3):

r

;\

_ ; sz et
j- : Siin ; @ :E *E S L/
; - ; : L Naci$nij i, trzymajac Y 2
weisniety m nasun|
. s e il ODydwa Obrysy na siebie

Rysunek 11.25.2 Wyprostowany obszar - trzeba jeszcz e dosun aé

Rysunek 11.25.3 Obrys statecznika po nasuni  eciu

Na koniec wywotaj polecenie Layer 2>Anchor Layer (—. To scali "ptywajacy" ponad rysunkiem, deformo-

wany obszar, z resztg obrazu, i zakohczy catg operacje.
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11.26 Skalowanie

Jezeli w GIMP jaki$ obszar jest wybrany (selekcjg) — zmiana skali bedzie dotyczyta tylko tego obszaru. Jezeli
jednak nic nie jest wybrane, zmianie ulega cata zawartos¢ pierwszej warstwy (tej "najbardziej na wierzchu").
Operacje pokaze na przyktadzie wiasnie takiej sytuaciji.

Wywotaj polecenie Tools 3Transform Tools Scale (lub [shift {T]). Pojawi sie okno dialogowe Scale (Rysunek

11.26.1). Zauwazysz takze pewne pogorszenie jakosci wyswietlanego obrazu. Linie staty sie mniej gtadkie, gdyz
GIMP przefaczyt sie na wyswietlanie "roboczej kopii" rysunku. Pokazuje teraz, jak bedzie wygladat obraz, gdy
zatwierdzisz te zmiane skali. (Czyli gdy nacisniesz przycisk Scale. Jezeli naci$niesz Cancel - zrezygnujesz z
calej operacji).

F-

Elle Edit Select Yiew Image Lawer Colors Tools  Dialogs  Filkers

B, kg oy o B O [ e O v e

Fi

1 1.Tu Kliknij (I I b =

= E_ " .,J ) I = Scale [5_(|

] rozprzac' zmiane i
| wymiar ) Scale

7 1 e Backgronnd-3 (P408-1)-Topxcfl
! H 1 Lt
1 i .

] : S width: | 2356 i‘ Jednostka miary
1 |2.Tu wpisz nowa .. . A\t K |- np. piksel!
I ] i

T 1 |szeroko$¢ lub  wyso- == |- Haht";az?l |" | pixels i |
1 Ko$¢E 2356 % 2827 pirels

| 8 300 ppi
I
e R

] ] \"'-',-;’%% [ Y ’ Help l I Scale l ’ Cancel

A : . :

a ] it

] e
-

= Skale mozesz takze zmie-

_ nia¢, fapiac za te

% uchwyty

0|

o

] ]

I-_ L7 __I
[ px v|| 15%. vI[Backgmund (53,9 ME)

Rysunek 11.26.1 Zmiana rozmiaru obrazu w kierunku p  ionowym

Zwrd¢ uwage, ze okno Scale nie przeszkadza w zmianie powiekszania widoku, ani w przesuwaniu poziomym i
pionowym suwakiem. To bardzo wygodne, gdyz z wiekszg doktadnoscig mozesz obserwowac¢ zgodnosc¢ linii
pomocniczej i linii na rysunku samolotu.

Jezeli nie zamierzasz zmienia¢ skali tak samo w obydwu kierunkach: upewnij sie, ze wysokos¢ i szerokos¢ sg
"rozprzegniete”. (Ogniwa tancucha w oknie dialogowym Scale powinny byé przerwane). Nastepnie w polu
Height lub Width wpisz nowy rozmiar obiektu.

Transformacje zatwierdzamy naciskajac przycisk Scale. Jezeli przeksztatcaliSmy tylko wybrany obszar, a nie

calg warstwe — po zakonczeniu skalowania nalezy dodatkowo wywota¢ polecenie Layer 2*Anchor Layer . To
"zatwierdzi" rezultat operaciji.
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11.27 Identyfikacja warto $ci RGB z obrazu wy swietlanego na ekranie

Czasami moze zaj$¢ potrzeba identyfikacji wartosci komponentéw R, G, B (wiecej na temat tych komponentow
— str. 604) jakiejs barwy, widocznej na ekranie. Na przyklad — jeden z serweréw wzoréw barw,
http://colorserver.net, pokazuje tylko obrazy probek koloru. Liczbowe warto$ci RGB nie sg tam nigdzie podane
(Rysunek 11.27.1):

- P Y
/= FED-STD-595 Federal Standard 595 Color FS 34151 M[=1E3
Q =4 T & htrpyfjcolorserver net/showeolor, asprfs=34151&bkgr=100 b (B AN B S Fo g
U0 4 | @FED-STD-595 Federal Standard 595 Color F5 34151 || S - B oo+ |k strona - 0 Narzedzia - @)
A
Federal Standard 595 Color FS 34151
Quer 2000 coiars sened dally Add Another Color
ow wilh Color History Secilon sk Abaut This Calar an Qur Forum
» Search colors
» Browse fan deck
» Browse by palette
» FAQ and Articles
» Color History Section
» Discussion forum L L
» User stories Prébka barwy, ktorej
»Linktous chcemy odczyta¢
» About this site warto$é komponen-
tow R, G, B.
» Bookmark this site
» Save to del.icio.us
FED-5TD-535 Spec Pantone UK
Federal Standard 585 Paint Colors Fan dedks, colours, products and guides for accurate colour
specs, chips & chip sets communication
n A tw Canoale M

Rysunek 11.27.1 Prébka koloru, wy swietlanego przez colorserver.net .

Aby skopiowa¢ zawarto$é jakiego$ innego okna, uruchom GIMP i z menu File wywotaj polecenie
Flle 2Create »Screen Shot (Rysunek 11.27.2):

* GNU Image Manipulation Program = WinSnap ﬁ]

=4 Edit Select Wiew Image Laver Colors Tools  Fikers  Script-Fu Windows  Help

(3} Grab a single window

[ From Clipboard ShiFE+CEr+Y @l EEb R 2. Nacisnij Gfab]

Chrl+M

[ open... Chrlo ScannerfCamera. ., . :
= Cpen as Layers. .. Chrl+AlE+O HH after | % Seconds delgy
@ open Location. .| 1- Uruchom Buttans »
Screen Shot... . »
Cpen Recent 4 ; l Help ] [ Grab l [ Cancel l

\
] g
2

= ( ) -
w | @8 FED-STD-595 Federal Standard 595 Color FS B4«

- —— |

Federal Standar ] -
3. Ztap D ten krzyzyk, przesun go i upusé

P link to 7 ~ . A
ermalne e ponad oknem, ktérego obraz chcesz skopiowac

Cancel

Rysunek 11.27.2 GIMP — uruchomienie kopiowania z za  warto $ci wybranego okna.

W oknie WinSnap nacisnij przycisk Grab. Potem wskaz za pomoca ,krzyzyka” z Select Window okno do sko-
piowania. Po chwili kopia wskazanego fragmentu ekranu zostanie umieszczona w oknie Gimpa.
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W GIMP wybierz narzedzie Color Picker (|§|, albo Tools >Color Picker ). Kliknij nim (|:[) w obszar, ktérego
barwe chcesz pozna¢ (Rysunek 11.27.3):

1 *Untitled-2.0 (RGB, 1 layer) 946x641 - GIMP

gEdit Select  Yiew Image Layer Colors Tools  Filkers  Scripi-Fu Windows  Help

Lol L |1_|U?|I Ll ||2|DQ| | T ' |3|DP| | I |4|U?|I L ||5|UQ| i . |5|DP| | I |F|U?|I Ll ||8|UQ| | B |g|DIF| \q
1. Wiacz narzedzie[ T T - =
o - ederal Sta,.. X it - B = gl = ([ tlerzedza « Bl §—
Color Picker R (cion -redwisrcrts. @rnsT e x| B8 8-t Qe @
rserver | Federal Standard 595 Color FS 34151

Permalink to This Page
iors served daily. Sampla S

5’ @@ E AEA rré‘) — e
B s SO LB & P

Add Another Color
Agk Ahcat This Solor on Sur Forum

. Articles
i Etory Section
/:ﬁ%\ @ @ ﬁj ‘ v forum
% e
5

- is site

u ; o

4l R 2. Kliknij kursorem

to dalicio.us

gdzie$ na obszarze

prébki
Wskazany

stanie  sie  barwag
pierwszoplanowa

PANTONF Fazhian+HAmE FFNFRAI .STANDARNRAAN

|ne] £
&<

i {_

547, 406 | piw BE.FYE vl p' Click in any image to pick the Foreground colar (tew Shift, Cerl)

Rysunek 11.27.3 GIMP — pobieranie barwy z obrazu

Color Picker zmienia kolor pierwszoplanowy (Foreground Color) na kolor piksela, wskazanego na obrazie. Teraz
wystarczy otworzy¢ okno edyciji tej barwy, by odczytac jego wiasciwosci (Rysunek 11.27.4):

* Change Foreground Color

[ H _ =
= / O L) ©d —
O I :
2. | odczytaj wartosci - ; P
R, G, B probki Oy * =
C . I |20
OIB
O & N |
3. Te same barwy, wyrazone

heksadecymalnie T~ |

HTML notation: |506224 ||

o _l v ] ) [ |
o: COC I CCiC ]

1. Kliknij I:l w ’ Reset H oK H Cancel l

pobrany kolor...

Rysunek 11.27.4 GIMP — odczytanie warto $ci R,G,B pobranego z prébek koloru

W oknie Change Foreground Color mozna odczyta¢ wartosci komponentéw barwy z pdl R, G, B. Sg podane
jako liczby catkowite z zakresu 0..255. W polu HTML notation te same liczby, ale w postaci heksadecymalnej
(szesnastkowej), sg ,sklejone” w jeden symbol.
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11.28 Definiowanie nowego p edzla

Czasami mozesz stwierdzi¢, ze potrzebujesz pedzla o innym
ksztatcie, nize te, ktore sag dostepne w przyborniku Brushes
(Rysunek 11.28.1).

Nic prostszego — w istocie tworzenie nowego wzoru pedzla w
Gimpie nie rézni sie specjalnie od stworzenia nowego rysunku.

W tej sekcji utworzymy nowy pedzel, ztozony z rozrzuconych
losowo pojedynczych pikseli, o ,twardych” (,ostrych”) krawe-
dziach. Taki pedzel bardzo sie przydaje do malowania przetar¢
farby na poszyciu samolotu.

Brushes (=]
S R

. '
+ d

A Fg 22

B . L - .
® ® = i &)
Spacing: j > :l
|
2 0O = @ E |

Rysunek 11.28.1 Przybornik Brushes — zestaw
pedzli r6 znego rozmiaru i ksztatu

Zacznij od stworzenia nowego rysunku (File 2New). Nadaj mu jaki$ niewielki rozmiar, a w ustawieniach za-
awansowanych zmien typ przestrzeni barw (Color space ) z RGBColor na Grayscale (Rysunek 11.28.2):

*® Create a Mew Image

Template: | Ustal jakies niewielkie rozmiary
pedzla (w tym przypadku —
: 16x16 pikseli)
Image Size
width: | 16 2
Height: |16 2 | pixels W

@ @ 16 = 16 pizels

72 ppi, Grayscale

= Advanced Options

% resolution; | TZ.000

% ®E

¥ resolution: |?2.EIIZIIII | pizelsfin vl

Color space: IlGraEcale W |

Eill with: |Ba':k'§|r':'\n¢':':'l':'r Zmien przestrzen barw ~ |

.............. — |naGrayscale
Comment:  |Jickered brush

Help ] I Reset (0] 4 Zancel

. Untitled-3.0 [gra‘yscaltk.. EIE”E'

File Edit Select Mjew Image Lawver Colol

|E||1|:'U,,,|5|:|,,,|U,,,,f':|,,,|1':|'3|""
- ~
17
£
i
'1 |
i
0
'5 -
LR
7 -
= 1
£
I:l -
: Utworzony obraz
] — W rozmiarze
é . rzeczywistym
|
1_ —
[ ot
i E3E:
i s | 100% | Backgru:uund e

Rysunek 11.28.2 Tworzenie nowego obrazu — wzoru p  edzla

Powinienes$ zacza¢ od obrazu zupetnie wypetnionego bielg. (Kolor biaty w pedzlu jest traktowany jako przezro-

czysty, a czarny — jako zupetnie nieprzezroczysty).
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Gdy juz znasz zasade, nic prostszego jak namalowaé¢ odpowiedni ksztatt. W tym przypadku chodzi o kilkadzie-
sigt rozrzuconych losowo pikseli. Wybratem wiec zamiast pedzla narzedzie o ostrych krawedziach linii: otéwek
, Tools 2Paint Tools »Pencil ), oraz najmniejszy pedzel, o rozmiarze 1 piksela (Rysunek 11.28.3):

BZ /O 28 & BX
e _‘( File Edit Select Wiew Image Laver Colors Tools  Filkers  Script-
';{?‘ @ §J ‘1, Wybierz B| [ |U T R | |5 [ R | |10| 1wl | |15| [ Jq-
- & narzedzie... 7 ~
L3 0| o e e e e T S S e s e '
- — 0 — 1 1
e — i | : !
:f::-:::"HjEf | | [ | [ | i
Brushes = M E . . E
e (1) (7 4 3] - : AN :
. -y ] | n |
+ i 4 n i i
1 : n
J 7 | |- ] 'H n - :
.‘ 2. ...Wybierz i | ;
©L Lt O T edzel.. & | u
00 - . 1 = :
4 4 4 i 4 - 1 !
S SR ] u
= e = 3. ...Powieksz 5 bmmmmmmmmmemmo—--——-—--o—-------- !
- ® =5 Ed e obraz... =,
] -
Spacing! --J— |_10.D : E P > 4'
B 0O = @8 & = , . _ e
12,4 |piw 1E00%5 ¥ f Click to paink (try Shift For a skraight line...

Rysunek 11.28.3 Rysowanie ksztaltu p edzla

Powieksz nasz malutki obraz do jakichs sensownych rozmiaréw — i rysuj. Gdy juz narysujesz pedzel, sprawdz,
do ktérego folderu nalezy go zapisa¢. GIMP podczas uruchamiania przeszukuje kilka folderéw w poszukiwaniu
plikéw z definicjami pedzli. Otwo6rz okno preferencji (Edit ?Preferences ), aby sprawdzi¢ (w Folders:Brushes ),
jakie to sa foldery (Rysunek 11.28.4):

Edit lielect View Image Laver Colors DD aaieriss rg|
Unda Pencil Ctrl+2
& | _ B Toolbox ~
@ F- @ Default Imags Brush Folders
<q‘j Undo Histary Default Grid
= E‘ Image: Windows [j 3
Cuk Chrl+i
= = EI Appearance Writable Folder
L) Copy ChrhC Title & Status CiDocuments and Settingsiwitold, jaworskil, gimp-2. 61brushes
Copy Yisible Shift-+Ctrl+C '__ﬁ; Disol O C:\Program Files\GIMP-2 . 0\sharelgimpl2. 0\brushes
[0 paste Chrl+Yy = Rt
B paste Into Color Management
Paste as 3 = E’i Input Devices
Buffer 4 3 Input Contrallers Pod Folders:Brushes  znaj-
. dziesz liste folderéw, w ktorych
o Clear Delete Window Managerment GIMP szuka plikéw z definicja-
B Fil with F5 Color Chrl, = E) Folders mi pedzli
O Fill with BG Color Chrl+,
I Fill with Pattern Chrlt; ) attems
w s &Palettes 0
o
= % Gradients
’ﬁ| Fonts
.{‘% Plug-Ins v ~
T |

Rysunek 11.28.4 Foldery, w ktérych s g wyszukiwane p edzle
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Gdy wiesz juz, do jakiego folderu trzeba zapisac plik, nie pozostaje nic innego, jak to zrobi¢. Wywolaj polecenie
File ?Save As (Rysunek 11.28.5):

E Save a Copy of the Image |
Nadaj plikowi nazwe — -

Name: |jitter.gbr| e I:onlecznle Z rozszerzeniem :I
| .gbr

B

[=l Browse For other Folders

B [T RET | Y Save as Brush Create Folder

Flaces Mar} Spacing: IEC Tu wpisz nazwe, jaka ma
& Recently .. B nosi¢ pedzel w palecie
¢ § Desctiption: |Jitter| 4 Brushes
[ witeld, jav... (=]
[ Desktop &=
“# Bonusy na... Ll ’ Belp l I 3ave l ’ Cancel
< Diysk lokal... = —
L Stacja dys... B amazing-green-mountains-with-tr...  2008-01-27
e Cdna i Bookmark_-_Rear_fs.jpg 2008-01-20
Z# Ferrodon... Bookmark_-_Rear_fs.PHNG 2008-01-20
2 dokument... &5 chutor. jpeg 2007-10-30
5 Mis na il |y |58 coud.jpeg 2007-10-30
SITICE |AII images w |

Select File Type (By Extension)

Rysunek 11.28.5 Zapisywanie obrazu jako definicjip  edzla GIMP (plik *.gbr)

Save l [ Cancel l

Wskaz odpowiedni folder i nadaj plikowi nazwe — koniecznie z rozszerzeniem *.gbr (,gimp brush”). Gdy naci-
$niesz przycisk Save, pojawi sie dodatkowe okno Save a Brush (Rysunek 11.28.5). W polu Description wpisz
nazwe pedzla — taka, pod jakg ma figurowa¢ w zaktadce Brushes .

Gdy uruchomisz ponownie GIMP, nasz pedzel powinien juz sie e &
pojawi¢ w zakfadce Brushes (Rysunek 11.28.6): Jitter (16 % 16)

Rysunek 11.28.6 Nowy p edzel w palecie GIMP
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11.29 Rozmycie metod g Gaussa

Jezeli w GIMP jaki$ obszar jest wybrany (selekcjg) — transformacja bedzie dotyczy¢ tylko tego obszaru. Jezeli
jednak nic nie jest wybrane, zmianie ulega cata zawarto$¢ aktualnej warstwy.

Rozmycie zademonstruje na przyktadzie ostrego, bialo-czarnego rysunku. Wywolaj polecenie
Filters 2Blur Gaussian Blur... (Rysunek 11.29.1):

Il “white.xcf-1.0 (RGB, 6 layers) 512x512 - GIMP =13
File Edit Select Wew Image Laver Colors Tools BElEEEEN Script-Fu o Windows  Help

3 ) R Jemal
L2 L o | LU @ Repeat "Gaussian Blur Chl+F 200 -

Fragment  rysunku,
ktory ma  zosta¢
LSozmyty”

Re-Shaow "Gaussian Blur” Shift+Cerl-+F

Recently Used L4

o Reset all Fikers

I

Blur

Enhance

Diskorts

Light and Shadow
Moise
Edge-Detect
Generic

Combine

Fragment rysunku, Ayrtistic
ktéry ma  zosta¢ e Decor
Jozmyty” Map
Render
Weh
Anirnakion

|||||||||.=JE

Gaussian Blur. ..
Mation Blur. ..
Pixelize. ..
Selective Gaussian Blur. ..
Tileable Elur...

[=T-Te

* rF rF T T T T T wowIwr o wrow

oo

&lpha to Logo 4

Scripk-Fu L4

T L

Rysunek 11.29.1 Menu efektéw rozmycia ( Blur)

W oknie dialogowym, ktére sie pojawi, ustaw odpowiedni Blur Radius (Rysunek 11.29.2). Im wiekszy promien
ustawisz, tym intensywniejsze bedzie rozmycie. Ma to takze wptyw na czas przeliczania catego obrazu (wieksze
promienie zabierajg procesorowi wigecej czasu).

8 Gaussian Blur @
s
~__|Podglad
4 |aktualnego Rezultat —
efektu rozmyty
obraz \
nr
s | [Rozmiar | /eb
Preview f ,fozmycia’
Blur Radius Blur Method
Horizontal: %|1IJ.D = % C ur
verticali (100 2 0 [px v ORE
o J[ e |

Rysunek 11.29.2 Okno polecenia Gaussian Blur i jego efekt
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11.30 Nanoszenie $ladow dymu i innych zabrudze n

Za pomoca Inkscape mozna wygenerowa¢ mape ,podstawowych zabrudzen”, biegnacych wzdluz krawedzi
paneli poszycia samolotu (por. str. 379). W tej sekcji pokaze, jak szybko wzbogaci¢ ten obraz o inne, mniej re-
gularne efekty — losowe zabrudzenia i $lady spalin.

Aby wygodnie nanosi¢ te elementy w GIMP, wczytaj na oddzielng warstwe (File 2Open as Layers) obraz uzy-
skany z Inkscape (Shadows.png ). Nie zapomnij zablokowa¢ tej warstwy (Rysunek 11.30.1):

;} % ; A a A Wybierz jako :;rnzqdzie

! 1 aerograf (E)

Yo

Aktualny kolor:
Fl czarny

|

FEID|

Layers Nowa warstwa, na ktorej
bedziemy malowa¢

Made:  Marmal

Cpacity

Lock: [ .

w00 o

" H Shadaws.png

Podktad: zablokowana
warstwa z obrazem
uzyskanym z Inkscape

e [i R — a2

Rysunek 11.30.1 Uktad warstw w GIMP

Ponad warstwg Shadows.png umie$¢ nowa, przejrzysta (Transparent) warstwe o nazwie Smoke. To na niej

bedziemy rysowac. Wybierz z palety odpowiednie narzedzie: — aerator (E).

Zmniejsz Opacity,
by delikatniej

Dobierz odpowiedni pedzel (z zakladki ) 2 [s] b) | #£|5e]

Brushes) — ten o nazwie Softer Brushes = Airbrush nakladaé barwe
Lofer (87 & £3) ode: ol i
(Rysunek 11.30.2a). ; = U :
. ’ / ._-‘ Ppacity:—D 100.0 g
o . . . h ft
Potem przejdz do zakladki narzedzia i AN v f’f'i--.EM?ff ___________________
ustaw jego parametry mniej wiecej tak, o o @ (cHaltpedza 5'\ R S O |
. . Pl Fl 4 Fl k i
jak to pokazuje Rysunek 11.30.2b): || @R [Scale  stervje
- Scale — nie za duza: 0.5; .. .. PPN | FIE rozmiarem pedzla
. , Apply Jite
- Rate — umiarkowane 20.0; .2 89w L) ey er
° "g:_‘ %ﬁ_ % >< [] Use color frarn gradient
Fl T Fl F . -
Jezeli chcesz naktada¢ efekt stopniowo i _ e ] 2 5
choes priowo | X B 8 T ot
powoli, mozesz dodatkowo zmniejszyé il R
wartos¢ Opacity ze 100 do, powiedzmy, EIE g8 2 = ol Y o

50 (Rysunek 11.30.2b).
Rysunek 11.30.2 P edzel do malowania dymu i jego ustawienia
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Teraz zacznij nanosi¢ slady brudu i spalin. Pamietaj, ze szczeg6lnie wyrazne powinny by¢ slady za kolektorem
spalin (Rysunek 11.30.3):

Stopniowo naktadaj

Uwazaj na przerwy . barwe za pomocg
L aeratora...
W rozwinigciu UV!

... by po chwili
osiagnagé taki efekt

Rysunek 11.30.3 Malowanie s$ladu spalin za rurami wydechowymi silnika

Aby uzyskac¢ inny efekt: zaciekow — zmien narzedzie na zwykly pedzel (Paintbrush — E) Zmieh takze

jego rozmiar na niewielka, rozmytg kropke (Circle Fuzzy). Uzyj go, by nanie$¢ ciemne punkty tam, skad majg
sie zaczyna¢ zacieki (Rysunek 11.30.4):

V=D

Brushes

Citle Foery (05 (7 % 7)

.I a
/‘ # i . i : ] Wybierz jakas
mata kropke...
. e o @ g Kropke
Fl Fl F rl
. - -

i narysuj ciemne punkty

- z\n"_’. % wszedzie tam, gdzie majg by¢
>4 + poczatki zaciekow

Rysunek 11.30.4 Zacieki: naniesienie punktéw pocz  atkowych
Potem przelgcz sie na ,rozmazywanie” (Smudge — : . Zmien rozmiar narzedzia na sredniej wielkosci

kotko (Circle) i zacznij rozmazywa¢ narysowane przed chwilg kropki zgodnie z kierunkiem oplywu powietrza
(Rysunek 11.30.5):
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PIED]

Brushes
Ot (13) (17 % 13)

Przetacz sie na co$
wigkszego, 0 wyraz-
nych krawedziach...

i zacznij rozmazywac
narysowane przed chwilg
kropki. Ro6b to zgodnie z
przypuszczalnym kierunkiem
optywu powietrza.

Rysunek 11.30.5 Zacieki: rozmazywanie ( Smudge )

,0goIne” plamy, o ksztalcie nie zwigzanym z kierunkiem optywu, uzyskasz w ten sam sposéb, tylko rozmazujac
je we rownomiernie we wszystkie strony (Rysunek 11.30.6):

Zwykie plamy to
kropki, rozmazane w
rézne strony

Rysunek 11.30.6 Zwykte plamy: kropki rozmazywane ( Smudge ) w r6 zne strony

Ciekawy efekt w plamieniu mozna uzyskag¢, przetaczajac narzedzie na gumke (Eraser — [shitt HE]) i zmieniajac
ksztalt pedzla na jakas ztozong, bezkierunkowag plame — np. Galaxy (Rysunek 11.30.7):

8=
Brushes =
Plama czesciowo Guls S AR
D r
wymazana za pomo- . ’ / @J
ca gumki (Eraser) o + i 4 4
ksztatcie Galaxy . P ) . .
Fi Fl 4 Fi Fl
e o o O O
Fl 4 a4 Fi F]
0 .
Fl Fl Fl
. L I B
Fl ] a4 Fl A
\, :
o =g < X
Fl }-’ + F] A
i [
i 1
Xa 4 E LI = @

Rysunek 11.30.7 Nanoszenie kontrastéw na plamach po  przez usuwanie ( Erase) ich cz esci
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Czasami dobry efekt daje takze wykonanie ,drugiego -
i " i i ( Zmniejszaj Opacity,
przebiegu” narzedziem o zmodyfikowanych parametrach. _I—T“' Zr’;]“r?i'eejlsszzile“ imepnasm’_ W

przypadku gumki mozna np. zmniejszyé jej intensywnos¢

nos$¢ usuwania

(Opacity), albo wiaczy¢ ostre granice efektu (Hard edge) — =
(Rysunek 11.30.8): e ¥ '_'|§_1nu.u F
Brush: | Galary, Small (AF) |
Seale: _l“ 1.0 :

[+] Brush Crynarnics
[] Fade out
D Apply Jitter

[] ncremental

| < Ciekawy efekt moze takze
Hard edge da¢ wiaczenie opcji Hard

edge.

|:| Anti arase (Al

Rysunek 11.30.8 Typowe zmiany ustawie H gumki
podczas korygowania plam
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11.31 Nanoszenie przetar € i odpryskéw farby

Kazda maszyna do chwili rozpoczecia eksploatacji, zaczyna ,obrasta¢” w slady zuzycia. W przypadku samolotu
sg to, miedzy innymi, odpryski i przetarcia farby. Wtasciwie naniesione, znacznie poprawiajg realizm modelu.
Kazdy typ samolotu ma charakterystyczny ukiad takich sladéw. Nim zaczniesz te skazy malowaé, warto naj-
pierw przejrze¢ zdjecia, aby okresli¢ ich potozenie, rozmiar i rodzaj. W czasie malowania uwazaj, by nie ulec
pokusie i nie pokrywac rysami catej powierzchni maszyny. W normalnej sytuacji obstuga naziemna nie prézno-
wala, i na biezgco zamalowywala spostrzezone uszkodzenia. Obszarem, z ktdrym nie byta w stanie sobie na
dluzsza mete poradzi¢, jest w dolnoptatach gdérne poszycie skrzydia, przy kabinie. Mimo odpowiednich ,dywani-
kéw”, widocznych na wielu zdjeciach, to miejsce zawsze byto porysowane butami pilotow i mechanikéw. Kazde
zamalowanie w tym obszarze szybko znikato. W tej sekcji pokaze, jak mozna uzyskac¢ efekt zuzycia powitok
samolotu wkasnie na przyktadzie tego fragmentu.

Do pracy bardzo sie nam przyda obraz linii nitdw i krawedzi paneli poszycia (np. wyeksportowany z wektorowe-
go pliku Inkscape). Wczytaj go na odpowiednig warstwe referencyjng: UV-Lines.png (Rysunek 11.31.1):

UV Lines jest nakia-
dana w trybie Multiply

Layers

Made:  Multiphy -
Opacity; ———————————————_| 1000
Lock: I:l.
a i 5 Ui lines.png  — - UV Lines zawiera

obraz szczegotow

: powierzchni samolotu
Rysy bedziemy

Color-Lamuflage malowaé na warstwie

. Color-Chips

8
@ §

Color-UC amuflage

Rysunek 11.31.1 Wstawienie warstw: podstawowejire ferencyjnej

Wstaw do rysunku takze nowg warstwe Color-Chips , na ktérg naniesiemy obraz rys na powierzchni.

Zmien aktualny kolor na biaty, i za pomocg ,ofowka” (E, Tools 2Paint Tools Pencil) oraz specjalnego pe-

dzelka o nazwie Jitter , zacznij rysowac¢ na warstwie Color-Chips obszar zluszczonej farby (Rysunek 11.31.2):

Brushes =
Jiver (16 x JE)

. - ’
/1/1' . ’

4 d A
o ©® . : i Zacznij rysowaé
4 a4 a4

a a (kolorem biatym)

4 4 b «|Wybierz ~ narzedzie
. Hi= [Pencil i pedzelek
4 _E-.g+ Jitter

Lo
T

K O bt

Rysunek 11.31.2 Wybér narz edzia i rysowanie
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Jitter to dodatkowy typ pedzla, ktéry stworzytem specjalnie do rysowania odpryskow farby. Plik z jego definicjg
znajdziesz w folderze source\gimp\brushes pod nazwag jitter.gbr. Aby stat sie widoczny w zakiadce Brushes,
wgraj go do jednego z folderéw ustalonych w konfiguracji Gimpa (zob. str. 661, Rysunek 11.28.4)".

Nadal uzywajac pedzla Jitter , przelacz sie na usuwanie barwy za pomoca ,gumki” (Eraser). Wigcz w zaktadce
wlasciwosci tego narzedzia opcje Hard edge (Rysunek 11.31.3a), i pousuwaj cze$¢ obszaréw odpryskéw, redu-
kujac je do wlasciwego ksztattu. Postaraj sie, aby ,plamy” bialego koloru mialy jak najbardziej realistyczny (a
jednoczesnie — chaotyczny) ksztait. To dobra okazja, by uwolni¢ w sobie uspionego impresjoniste ©. Postaraj
sie uwzgledni¢ mniej przetartg powierzchnie w drobnych zagtebieniach — na przyktad wokét srub (Rysunek
11.31.3b):

a) a_
=

Mode: |Nu:mai |

Aktualne narzedzie:
= ,gumka” (Eraser)

Crpacity

Aktualny pedzel:
Brush:

: Jitter . Wymaz czes¢ biatych obszarow w
. ] i B zagtebieniach blachy wokot $rub

Erush Doynamics

[] Fade out

] apply Jitter

l:l Incramental

Hardedge ¢—— Wigcz ,twarde krawedzie”
(Hard edge).

D Anti arase (Al

= @ ol

Rysunek 11.31.3 Ustawienie ,gumki” i usuwanie nadda  tkow

Rysunek 11.31.4 pokazuje narysowang na warstwie Color-Chips bialg plame, ktéra na modelu wyglada jak
zluszczenie farby:

Rozwinigcie

Fragment zluszczenia na
oprofilowaniu krawedzi
skrzydta i kadtuba

Rezultat (podglad
w Blenderze)

L

Rysunek 11.31.4 Przyktad efektu tuszcz acej si e farby

Zwr6¢ uwage, ze kazda ze stron tego fragmentu byta na obrazie tekstury malowana osobno: cze$¢ na rozwinie-
ciu kadtuba(Rysunek 11.31.4a), a cze$¢ — na rozwinieciu ptata (Rysunek 11.31.4b). Mimo pozordw, niespecjal-
nie staratem sie te dwie plamy ,zsynchronizowaé¢”. Zlozenie wyszto ,samo” (Rysunek 11.31.4c) — wydaje mi
sie, ze caitkiem dobrze.

! W istocie pedzel Jitter to raptem kilkanascie ostrych, czarnych kropek. Jezeli sam chciathy$ przygotowaé swéj wiasny pedzel — p. str.
660.
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Odchodzaca catym ptatami farba swiadczy o kiepskich sktadnikach, uzytych do jej produkcji, i/lub problemach z
obstugg naziemng'. Powtoki nanoszone bezposrednio w zaktadach Curtissa byly dobrej jakosci. Przejrzatem
wiele zdjec¢, ale nawet na szkolnych P-40, uzywanych intensywnie przez kilka tadnych lat, nie znalaztem $ladu
luszczacej sie farby. Co najwyzej — przetarte ,do gotej blachy” pokrycie tam, gdzie wszyscy chodzili: na krawe-
dzi kadtuba i skrzydet.

Malowanie przetarcia zacznij od przygotowania odpowiedniej maski, poprzez ktérg bedziemy nanosi¢ barwe.
Najtatwiej jest ja narysowaé w trybie Quick Mask , szczegoty — str. 650) (Rysunek 11.31.5b):

) o saE

Wybierz narzedzie: ||
s

~gumka” (Eraser)

Umiarkowana
Bhush: L ] | Circle Fuzzy [19) moc”
4

Scale: - J— 1.00 :

Erush Doyrigmics

Cipacity:

Ksztalt pedzelka: o
[] Fade our rozmytych krawedziach

l:l Apply Jitter
[] Tneremental

l:l Hard edge

[] anti erase (Al

Usun z maski obszary,
ktore majg by¢ przetarte

Rysunek 11.31.5 Efekt przetarcia — przygotowanie ma  ski (tryb Quick Mask )

Z maski usun za pomocg ,gumki” (Eraser) kolor z tych obszaréw, ktére majg by¢ poprzecierane. Stosuj tu w
duzym stopniu obszary polprzezroczyste — aby przetarcia ptynnie zanikaly w otoczeniu. Aby to osiagnagc,
zmniejsz nieprzejrzystos¢ (Opacity) ,gumki” do 50%. Do usuwania stosuj pedzelek o rozmytych brzegach
(Circle Fuzzy — Rysunek 11.31.5a).

Teraz wytacz Quick Mask i zacznij malowa¢ biate linie zarysowan powtoki. Uzyj do tego zwyktego narzedzia
Paint Tool ijednego z dotaczonych do tej ksigzki pedzli (source\gimp\brushes\lines.gbr) (Rysunek 11.31.6):

?) |/l b)

Brushes Zmien narzedzie
Lines-00 (37 x 323) na Brush
\ Linia granicy 50% przej-
a , 4 /J / 4
Kl . ] b 2
e o 0 0 O
4 4 4 4 4
o .
¢ & @° @ @ Wybierz ksztatt pedzla:
i . “ . ‘ chaotyczne linie (Lines)
“eoxo X X
] "] 3
B = e
+ +
- @
. . e iy b
Rysunek 11.31.6 Efekt przetarcia — nanoszenie linii ~ ,zadrapa R”

! Duzo ,zluszczen” widaé na zdjeciach samolotéw japonskich, operujacych w trudnym, goracym klimacie potudniowej Azjii i wysp Pacyfiku.
Innym przypadkiem takiego ,obtazenia” byly francuskie Hawk 75 pod koniec maja i w czerwcu 1940r. (Curtiss dostarczat je w barwie natu-
ralnego duralu. Kamuflaz byt nanoszony juz po odbiorze, w warsztatach francuskich)
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Aby znalezé pokazywane przez Rysunek 11.31.6a) pedzle Lines w przyborniku Brushes, musisz przenies¢ pliki
*.gbr do jednego z folderéw, figurujgcych w konfiguracji GIMP (zob. str. 661). Alternatywnie — mozesz dopisa¢
w ustawieniach GIMP folder source\gimp\brushes jako jeden z folderéw z definicjami pedzli.

Podczas malowania za pomocg koncéwki Lines unikaj naktadania rownolegtych linii blisko siebie. Umies¢ ko-
lejne ,przytozenia” narzedzia w takiej odlegtosci, by wida¢ byto pojedyncze kreski (Rysunek 11.31.6b).

Aby uczyni¢ ukfad rys na powierzchni bardziej chaotycznym, zmien teraz ksztatt koncéwki na pedzel Scratches
(Rysunek 11.31.7a):

V=Dl ]

Brushes

Obszar  zaznaczenia b
Part 2.3 (Soraches) (378 % 290) ogranicza  nanoszone [ T 5
% ‘ 4 2 ~ za pomoca pedzla rysy [af

. . . i ]
a4 4 a4 a 4

e o 0 00O
y i P "

® .

Woybierz ksztalt pedzla:
it 5 rysy (Scratches )

A Y

Rysunek 11.31.7 Efekt przetarcia — nanoszenie innyc  h skaz powierzchni

Wz6r tego pedzla — plik scratches.gbr — jest w tym samym folderze, co pozostate wzory dotaczone do tej
ksigzki (source\gimp\brushes). To relatywnie duza koncéwka (Rysunek 11.31.7b). Nie przejmuj sie jednak tak
bardzo jej rozmiarem. Zaznaczony obszar rysowania skutecznie ograniczy jej zasieg. Tak samo jak linie, nanies
jej obrazy kolejnymi ,kliknieciami” tak, by nie naktadaty sie na siebie.

Na koniec mozna troche ograniczy¢ r6zne naddatki plam, ktére w nieunikniony sposéb pojawity sie podczas
malowania. To ten sam finalny krok, co w przypadku odpryskéw farby. Zmieh z powrotem narzedzie na ,gumke”
(Eraser). Tym razem wymazywanie ma dziata¢ z petng ostroscig, wiec zwieksz Opacity narzedzia Eraser do
100%, i wigcz opcje Hard edge (Rysunek 11.31.8a):

s Narzedzie: ,gumka”
|I=='| (Eraser)

Ei
raser 100% (=]

MMode: [ nieprzejrzystosci |

Opacity:-—j|1gu,u =] Usuwaj raczej
peryferia, a nie

Brush: “@J itter Wzor: Jitter srodki

b)

Scale: —J— b -
Bruzh Dvynamics

I:‘ Fade out

D Apply Jitter

[ tncremental

Hard edge ,Ostre  krawe-
dzie” usuwania

I:‘ Anti araze (AL

Rysunek 11.31.8 Efekt przetarcia — usuwanie naddatk 6w

Wylacz ograniczenie do zaznaczonego obszaru (Select 2None). Wybierz pedzel Jitter . Uzywajac ,,gumki” tego
ksztattu, postaraj sie zmieni¢ granice wytartych obszaréw na mniej regularne (Rysunek 11.31.8b).
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Wyeksportuj tak przygotowany obraz barw do pliku. We whasciwosciach tekstury w Blenderze mozesz zmniej-
szy¢ wartos¢ filtru (Map Image:Filter — Rysunek 11.31.9), aby wyostrzy¢ rysy, namalowane na warstwie
Color-Chips :

B~ rane cERO@ FoE:

I

|(- 3
¥

m Miovie Sequence | Generated |
|

Ik olor g | Feload [x

Warld Lzesioha I : 1
e | (& |4, Mextures'E. 094zalor ong ¥
e[ [min]« Fiter-0200  + [Mormal Map [Tangent = | %
Brush
L TR | Extend | Clip | ClipCube Checker — —
Zmniejsz filtr ponizej
Alpha [Mirr [+ wrepeat:1 [mirc [+ Wrepeat:1 - | warto$ci 0.5
[ Mnxoood s Maxdiooo |
[+ Minv0000  c[4 Max¥ 1000 -

Rysunek 11.31.9 Wyostrzenie obrazu tekstury poprzez ~ zmian e filtra

Rysunek 11.31.10 pokazuje, jak nasze przetarcia prezentuja sie w réznych ujeciach modelu:

Reszta  powtoki

wyglada na ,zbyt
nowa”

Intensywnie
przetarcia

Intensywnie
przetarcia

Rysunek 11.31.10 Przetarcia na modelu (petna intens  ywno $¢)

Mowiac szczerze, efekt jest na tyle intensywny, ze reszta powierzchni wydaje sie wrecz wotaé o podobne ,prze-
tarcie”! To oznaczatoby duzo pracy. Na szczescie, obsluga naziemna zazwyczaj stawata na wysokosci zadania
a samoloty podczas wojny rzadko kiedy majg sie okazje az tak zestarzeé.

Zmniejsz w GIMP nieprzejrzysto$¢ warstwy Color-Chips do ok. 50% (Rysunek 11.31.11a). Rysunek 11.31.11b)
pokazuje, jak ,zbladly” w wyniku tej zmiany rysy na gérnej powierzchni ptata. Gdy wyeksportujesz ten obraz do
pliku dla Blendera, uzyskamy na modelu wtasciwe, ,umiarkowane” przetarcia (Rysunek 11.31.11c):

a.) ers =
Made:  Marmnal b
Opacity! - ] £0.0 | k4
Lack

Zmniejsz
in Nieprzejrzystos¢
warstwy do 0.5

Color-céncrete.jp-
'

Calor-LZamufage

Prawidiowe,
Colar-UCarnufage L,umiarkowane”
przetarcia

Rysunek 11.31.11 Efekt przetarcia — zmniejszenie in  tensywno sci
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. Rysy na poszyciu warto malowac¢ jako bardzo wyrazne — tak, jak na jakims ,starym gracie”. Potem zawsze
mozesz je stonowaé, adekwatnie do stopnia zuzycia odwzorowywanego egzemplarza samolotu. Wystarczy
zmniejszy¢ nieprzejrzystos¢ (Opacity ) warstwy Color-Chips .

Jezeli producent samolotu uzywal jakiej$ kontrastowej farby podktadowej (w wielu samolotach z USA byta to
jasna, zétozielona Zinc Chromate ), mozesz sprobowac jg odwzorowac¢. Dodaj do rysunku GIMP jeszcze jedng
warstwe: Color-Primer . Umies¢ jg pod warstwg Color-Chips . Zaznacz calg zawarto$¢ Color-Chips
(Layer 2Transparency —2Alpha to Selection ), i powieksz jg o 1-2 piksele (Select 2Grow... ). Potem zalej tak
zaznaczony obszar na warstwie Color-Primer barwa farby podktadowej. Uzyskasz w ten sposéb wokét przetaré
wotoczke” w barwie podktadu. To moze podniesc¢ realizm rys na powierzchni. W przypadku modelu P-40 darowa-
lem sobie ten element. Kolor farby podktadowej (Curtiss Green ) tak niewiele odr6znia sie od barwy powierzch-
ni gornych, ze ,otoczka” w tym kolorze byta niemal niezauwazalna. Rysy na powierzchniach dolnych sg na tyle
nieznaczne, ze nie ma sensu tworzy¢ tego efektu wytgcznie dla nich.

Cho¢ sam pisatlem, na poprzedniej stronie, ze powierzchnie P-40 byly traktowane ,z nalezytym szacunkiem”,
pokaze jeszcze, jak uzyska¢ drobne rysy wzdtuz krawedzi czesto zdejmowanych paneli. Rysuje sie je prosciej
niz ,szerokie” przetarcia, takie jak u nasady skrzydta.

Zmien aktualny kolor na bialy, narzedzie — na Paint Tool, i wybierz bardzo cienki pedzel (Circle 03). Narysuj
wzdtuz krawedzi, ktére majg by¢ porysowane, cienka biatg linie (Rysunek 11.31.12):

a Linie  prosta  uzyskasz,
trzymajgc wcisniety

Cienkie, biate linie wzdtuz
krawedzi  zdejmowanego

: Linie rysuj doktadnie na krawedzi
(wykorzystaj obraz UV, aby
doktadnie w nie ,trafi¢”)
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Rysunek 11.31.12 Zu zyte kraw edzie — naniesienie linii bazowej

Nastepnie zmien pedzel na Jitter , i dodaj po ,pacnieciu” w okolicach kazdej sruby (Rysunek 11.31.13a). Potem
ogranicz te ,pacniecia” i poprzerywaj biatg linie za pomoca ,gumki” (pedzel bez zmian: Jitter ), z wigczona opcja
Hard Edge (Rysunek 11.31.13b):
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Rysunek 11.31.13 Zu zyte kraw edzie — malowanie i wycieranie
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Na koniec jeszcze namaluj najdrobniejszym pedzlem, gdzie$s na srodku kazdego panelu, pare chaotycznych
kropek — aby nie byto tam ,za czysto” (Rysunek 11.31.14a):
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e 3 C . . i Wyrobione”
i 5 s krawedzie panelu

Chaotyczne kropki
w $rodku obszaru

Rysunek 11.31.14 Zu zyte kraw edzie — ostatnie dodatki i efekt finalny

Rysunek 11.31.14b) przedstawia ostateczny efekt na modelu (po zmniejszeniu nieprzejrzystosci warstwy Color-
Chips do 50%). Uzyskalismy dyskretne rysy, podkre$lajgce nieco krawedzie okapotowania silnika (na modelu
wyszty nam zbyt doktadnie dopasowane, wiec staram sie je w ten sposéb dodatkowo wyrdznic).

Rysowanie przetaré, zadrapan i zabrudzen to zajecie, w pewnym sensie, artystyczne. Czesto dwa zupenie
rézne (i wykonane réznymi technikami) obrazy tekstur znajdujg jednakowo wysokie uznanie wsréd widzéw. Pod
zadnym pozorem nie nalezy traktowa¢ metod, ktére przedstawitem w tej sekcji, jako ostatecznych. Pokazatem
tu kilka rzemieslniczych ,sposobow”, jak osiggna¢ efekt na — badzmy szczerzy — $rednim poziomie. (To zna-
czy na poziomie, ktory przynajmniej nie razi widza). Na pewno mozna to zrobi¢ lepiej lub inaczej. Jestem pe-
wien, ze z czasem dopracujesz sie swojego wlasnego stylu.
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11.32 Przeksztatcenie mapy szaro $ci w map e normalnych ( normal map )

Mapg normalnych (normal map) nazywa sie w grafice komputerowej obraz, w ktérym kazdy piksel przechowuje
konkretne wspétrzedne kierunku wektoréw prostopadtych do powierzchni modelu (tzw. ,wektoréw normalnych”).
Mapy normalnych pozwalajg uzyskac bardziej ,przestrzenne” efekty niz mapy nieréwnosci (bump map), oparte
na odcieniach szarosci'. W tej sekcji pokaze, jak przeksztalci¢ zwykly obraz szaro$ci w mape normalnych.

Zataduj do Gimpa obraz, ktéry ma zosta¢ przeksztalcony. Nastepnie wywotaj polecenie
Filters 2Map 2Normalmap (Rysunek 11.32.1):
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Rysunek 11.32.1 Wywotanie wtyczki  Normalmap .

e Jezeli w swoim menu Filters 2Map nie widzisz polecenia Normalmap — najprawdopodobniej nie zainsta-
lowates tej wtyczki. Zréb to, zgodnie z opisem umieszczonym na stronie 622.

Po wywotaniu polecenia pojawi sig okno dialo-  REFTREAPES
gowe (Rysunek 11.32.2) . Zawiera duzo réz-
nych parametrow, oraz niewielki podglad na

Presiew

ket Opkions
Wybierz | Fiker: /vl i hd] s
filtri skale |[——m@™ ——————— = Wrap
_ MinimumN [0.00000

mozliwy rezultat dziatania. _ [ mnwert %
Wiasciwie nie musisz sie przejmowac wigk- [ swap RGE
i 5 Height source: | Average RGE

szoscig widocznych w oknie kontrolek. Wy-
bierz z listy Filter jeden z dostepnych algoryt-

Alpha channel; | Unchanged W

méw (osobiscie proponuje 9x9). Po wybraniu Comersion: | Mone v

filtra moze okaza¢ sie konieczne dopasowanie L 3D Preview ”DU — @

skali (Scale). spbaman: N\ | _
e

Przejscie do| |
| lepszego podgladu

Podglad po prawej stronie okna jest zdecydo-
wanie za maly, by dobrze oceni¢ rezultat wy- [ Cancel ] [ oK
konanych ustawien. Na szczescie jednak, po

nacisnieciu  przycisku 3D Preview mozesz Rysunek 11.32.2 Okno dialogowe wtyczki ~ Normalmap

! Gdy Blender odwzorowuje nieréwnosci za pomoca mapy szaroci (bump map), musi podczas renderowania ,w locie” oszacowaé, jak
odchylony jest kierunek normalnej w aktualnym pikselu (tekselu). Zazwyczaj stara sie to zrobi¢ prébkujac obszar wokét takiego punktu.
Wtyczka GIMPa pozwala zawczasu przeksztatcic mape nieréwnosci w mape normalnych, gdzie konkretnemu pikselowi jest przyporzadko-
wana odpowiednia barwa. Wartosci R, G, B jego koloru sg traktowane jak wspotrzedne X, Y, Z kierunku wektoréw normalnych.
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zobaczy¢ o wiele wiecej (Rysunek 11.32.3):

**® Normalmap. - 3D Preview
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Rysunek 11.32.3 Dodatkowe okno podgl adu efektu dziatania mapy normalnych

W oknie 3D Preview wigcz potyskliwo$¢ (Specular lighting ) i ustaw barwy rozpraszania (Diffuse color ) i od-
btyskéw (Specular color ) na odcienie szarosci. Mozesz obok ustawi¢ okno dialogowe, i obserwowaé, jaki
wplyw ma zmiana konkretnego parametru. Gdy juz je dobierzesz, zatwierdzasz parametry naciskajgc OK w
oknie Normalmap . Wtyczka dokona wéwczas konwersji obrazu (Rysunek 11.32.4) :
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Rysunek 11.32.4 Uzyskana mapa normalnych
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